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Disclaimer
AVEVA Instrumentation provides instrument sizing calculations for estimation purposes only, end users of the
software should not rely on the calculations produced by the software for design purposes. End users should seek
the advice of certified equipment suppliers prior to specifying or purchasing equipment. 

To the fullest extent permissible at law: 

a) AVEVA does not warrant that the use of the AVEVA software will be uninterrupted, error-free or free from viruses; 

b) AVEVA shall not be liable for: loss of profits; loss of business; depletion of goodwill and/or similar losses; loss of
anticipated savings; loss of goods; loss of contract; loss of use; loss or corruption of data or information; any
special, indirect, consequential or pure economic loss, costs, damages, charges or expenses which may be
suffered by the customer, including any loss suffered by the customer resulting from the inaccuracy or invalidity of
any data created by the AVEVA software, irrespective of whether such losses are suffered directly or indirectly, or
arise in contract, tort (including negligence) or otherwise; 

c) AVEVA's total liability in contract, tort (including negligence), or otherwise, arising in connection with the
performance of the AVEVA software shall be limited to 100% of the licence fees paid in the year in which the
customer's claim is brought. 

In the event of any conflict between the above clauses and the analogous clauses in the software licence under
which the AVEVA software was purchased, the clauses in the software licence shall take precedence. 

Copyright
All intellectual property rights, including but not limited to, copyright in this manual and the associated software,
(including source code, object code, and any data) belongs to or is validly licensed by AVEVA Solutions Limited or
its subsidiaries. 

All rights are reserved to AVEVA Solutions Limited and its subsidiaries. The information contained in this document
is commercially sensitive, and shall not be copied, reproduced, stored in a retrieval system, or transmitted without
the prior written permission of AVEVA Solutions Limited. Where such permission is granted, it expressly requires
that this Disclaimer and Copyright notice is prominently displayed at the beginning of every copy that is made. 

The manual and associated documentation may not be adapted, reproduced, or copied, in any material or
electronic form, without the prior written permission of AVEVA Solutions Limited. The user may also not reverse
engineer, decompile, copy, or adapt the associated software. Neither the whole, nor part of the product described in
this publication may be incorporated into any third-party software, product, machine, or system without the prior
written permission of AVEVA Solutions Limited, save as permitted by law. Any such unauthorised action is strictly
prohibited, and may give rise to civil liabilities and criminal prosecution. 

The AVEVA products described in this guide are to be installed and operated strictly in accordance with the terms
and conditions of the respective licence agreements, and in accordance with the relevant User Documentation.
Unauthorised or unlicensed use of the product is strictly prohibited. 

Copyright 2000 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved. 

The AVEVA Instrumentation user interface is based on the Microsoft® Office Fluent™ user interface. 

Trademarks
AVEVA and Tribon are registered trademarks of AVEVA Group plc or its subsidiaries. AVEVA product names are
trademarks or registered trademarks of AVEVA Solutions Limited or its subsidiaries. Unauthorised use of
tradema
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Introduction
1 Introduction

The Instrument Designer User Guide is designed to help users learn how to use the
Instrument Designer module of AVEVA Instrumentation. The User Guide describes how to
create automated Loop and Termination diagrams from cable and wiring data.

Instrument Designer manages all tasks typically handled by an Instrument Designer during
a project life cycle including CAD drawing generation, drawing list management, updating of
revisions and printing of CAD files for loop diagrams, termination diagrams, Hookups etc.
Instrument Designer can be used to:

• Manage all project drawings and drawing revisions (including batch update, batch
revision changes and plotting) from a Graphical User Interface.

• Generate loop drawings from templates with updated attributes from the AVEVA
Instrumentation database including:
• Data from Instrument Engineer (Manufacturer, model number., range, P&ID

drawing numbers., I/O etc).
• Data from AVEVA Instrumentation Wiring Manager (Cables, terminations, wire

numbers etc).
• Data from the Instrument Designer drawing register (e.g Drawing No, Title, Drawn

By, Date etc) and revision history is automatically updated on all drawings.
• Generate Termination drawings parametrically from the AVEVA Instrumentation

database including:
• Data from AVEVA Instrumentation Wiring Manager (terminal strips & devices,

cables and core markings/wire numbers etc).
• Data from the Designer drawing register (e.g Drawing No, Title, Drawn By, Date etc)

and revision history is automatically updated on all drawings.
• Generate Hookup drawings with Bill of Materials and create bulk Bill of Materials

reports for an entire project.
• Access Engineering Data created with other AVEVA Instrumentation applications

including:
• Instrument and Loop data created with the Instrument Engineer application.

• Auto generate field device wiring including Junction Box termination via AVEVA
Instrumentation Using Wiring Rules to Create Data.

• Access Termination data created with the AVEVA Instrumentation Wiring Manager
application.

• Produce reports:
• Drawing List.
• Changes to Drawings.

AVEVA Instrumentation Designer utilises Autodesk's AutoCAD application to allow:
• Industry standard drawing/document exchange (data is never lost in a proprietary

database).
12 Series1:1© Copyright 2000 to current year.
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• AutoCAD is used to define loop diagram layout. Users have total control over drawing
standards, symbology and drawing format.

• AutoCAD attributes are “linked” to the database for data transfer to each drawing. That
is any information that is changed in the AVEVA Instrumentation database (e.g. a Tag
Number, Cable No, wire marking etc) is automatically updated in the appropriate
drawing (the next time it is updated - updating can be done in batch mode). 

• Print/update any number of selected drawings via the Drawing List (Drawing Register).

Loop data entry forms in Instrument Engineer and Wiring Termination forms in Wiring
Manager can be accessed directly from within Instrument Designer. Licenses for AVEVA
Instrumentation Engineer/Wiring Manager are required to access these forms.

Important: Instrument Designer uses data created by Instrument Engineer and AVEVA
Instrumentation Wiring Manager to generate CAD drawing files automatically
from the AVEVA Instrumentation project database. Normally this is the last
AVEVA Instrumentation module used on a project as Instrument Engineer is
used to create instruments tags and assign tags into 'loops'. AVEVA
Instrumentation Wiring Manager is used to create equipment, cables and wiring
including terminations. Without this data Instrument Designer cannot create
completed drawing files. 

For more information refer to Feature Overview.

1.1 Feature Overview
Instrument Designer handles automated generation of CAD drawings from multi-user
project/plant databases. It manages the process of CAD drawing creation, drawing revision
update, transferring of data to drawings, parametric creation of termination (wiring) drawings
and printing CAD files. 

Drawing List Management
• Add/Edit/Update/Delete/Open drawings from the Drawing List (register) manually.
• Add loop drawings automatically from Instrument Engineer's Loop List.
• Add termination drawings automatically from Wiring Manager's Equipment List.
• Manage drawing revisions (update all selected in “batch” mode).
• Create new revisions using next revision number or Update current revisions with new

information.
• Updates all drawing data:

• Drawing title block from Drawing List (titles, drawing no, plant area etc).
• Revisions from Revisions history.
• Engineering Data from any Instrumentation database field.

• Link drawing text fields to any user defined database field using AVEVA
Instrumentation Datalinks or SQL queries.

• Create/update and print selected drawings in batch mode.
• Print selected drawings in batch mode.

Loop Drawing Generation
• Create multiple drawings based on user templates (fully user definable).
• Edit drawings and update existing drawings without templates.
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• Updates cable/termination data from Wiring Manager (e.g. Cable, Terminal and Wire
Numbers etc.).

• Updates Instrument data from Instrument Engineer (e.g. P&ID No, Manufacturer,
Model No., Range, DCS/PLC I/O information etc.).

• Updates title block information (titles, revisions etc) and stacks revision history.

Termination Drawing Generation
• Creates drawings based on:

• Templates (typically termination schedules).
• Parametrics/Automated drawing (typically termination diagrams) - user defined

parameters - fully automated drawing creation.
• Updates cable/termination data from Wiring Manager (e.g. Cable, Terminal and Wires

No.'s).
• Supports cross-patch wiring and links between terminals.
• Supports automatic continuation over multiple drawings (e.g. Marshalling Racks etc).
• Supports automatic reference drawing numbers to loop diagrams for field cables & To/

From equipment & drawing numbers for termination drawings.
• Updates title block information (titles, revisions etc) and stacks revision history.

Hookup/Installation Drawings
• Assign tags to Hookup Type (Hookup drawings are user definable using AutoCAD).
• Assign Hookup Items from user definable catalogue (AVEVA Instrumentation currently

has over 3000 catalogue items already entered).
• Auto create Drawings with Bill of Materials and Tag List.
• Project Bill Of Materials (BOM) reports (by Plant Area and Total Project BOM).

Change Management
• Report all drawings added, deleted and renamed.
• Report detail changes in each field (e.g. Drawing No. now ABCD was XYZ).
• Log changes for future reporting (e.g. 8/7/99 Drawing No. XYZ: Cable No. 1234 was

4567 etc).
• Audit Manager enables users to view changes by object type.

Integration

The Designer is integrated with other AVEVA Instrumentation applications.
• Loop Drawings automatically added to Drawing List from Engineer.
• Tag Numbers, service, range, manufacturer, model no. etc updated from Engineer.
• Equipment, cables, terminations, wire numbers. etc automatically updated from Wiring

Manager.
• Loop Drawing No. is passed to Instrument Engineer's Instrument List (Index).
• Hookup Drawing number is passed to Instrument Engineer's Instrument List (Index).

Designer can be used on any existing AutoCAD drawings and allows drawings to be
updated from the Instrumentation databases (Instrument Engineer, Wiring Manager or user
defined) without requiring use of templates. For example, several loop drawings could be
initially generated from a standard loop definition (template), then any number can be edited
and made non-standard, but the information can still be updated automatically from the
original databases.
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Reports and associated data can be exported to AVEVA NET.

User Security Rights

An AVEVA Instrumentation administrator can set security rights for users to enable/disable
access to AVEVA Instrumentation functionality including:

• Access to AVEVA Instrumentation application modules - users can be restricted from
using any module (license).

• Access to AVEVA Instrumentation objects can be restricted to read-only (e.g. a user
cannot add/edit a drawings) or no access (i.e. the user cannot view an instrument etc.).

AVEVA Instrumentation objects include project entities such as cables, instruments,
drawings, reports etc and catalogues, the importing of data etc.

By default all new projects have the Security Rights features disabled for backward
compatibility with earlier versions of AVEVA Instrumentation. If security is required it must be
turned on using the Security Manager. Users must then be allocated to 'Security Groups'
such as Engineers and Designers, Read-Only Users etc. Refer to the Security Manager
documentation for more information.

1.2 System Requirements
For the minimum system requirements needed to run AVEVA Instrumentation, refer to the
Installation User Guide.

1.3 AVEVA Instrumentation
For an overview of AVEVA Instrumentation, its features and benefits, refer to the Common
Functionality User Guide.

1.4 Guide Structure

Introduction a brief description of Instrument Designer.

User Interface begins by displaying the View tab of Instrument Designer.

Options describes how to set various Designer options and preferences

Areas all objects are based on Plant Areas, once the project is setup
the first task is to add the various plant areas to the project
database.

Drawing List is the main Designer window for adding/editing and accessing
drawings.

Drawing Generation how Designer generates CAD drawings from the Drawing List.

Hookups drawings are created by assigning a pre-defined Hookup
Template to each project hookup drawing.

Engineering Data allows access to the Instrument Engineering data normally
created by the Engineer application.
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Using Wiring Rules to
Create Data

to auto generate typical field instrument wiring/cabling.

Exports includes facilities to export files of item data and report PDF
files for import into AVEVA NET.

Work Packs can be created with selected equipment and time scales for a
particular project.

Change Reports has an in-built Audit Manager that enables users to view
database changes made during the project in the database
audit log.

Reports that enables users to create and modify reports.

AVEVA NET Export 
Configurations Files

explains the configuration required for AVEVA NET Export.
12 Series1:5© Copyright 2000 to current year.
AVEVA Solutions Limited and its subsidiaries. 
All rights reserved.



Instrument Designer User Guide
Introduction
12 Series1:6© Copyright 2000 to current year.
AVEVA Solutions Limited and its subsidiaries. 
All rights reserved.



Instrument Designer User Guide
User Interface
2 User Interface

Important: Instrument Designer uses data created by Instrument Engineer and Instrument
Wiring Manager to generate CAD drawing files automatically from the AVEVA
Instrumentation project database. Normally this is the last AVEVA
Instrumentation module used on a project, as Instrument Engineer is used to
create instruments tags and assign tags into 'loops' and Instrument Wiring
Manager is used to create equipment, cables and wiring including terminations.
Without this data Instrument Designer cannot create completed drawing files.

When Instrument Designer starts up the AVEVA Instrumentation Designer window is
displayed showing the Home tab.

The Select an AVEVA Instrumentation Project window is also displayed.

Continue at:
• Open an AVEVA Instrumentation Project
• Instrument Designer Tabs
• Select a Language
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• Select a Colour Scheme
• Working with the Data Grid
• Finding and Replacing Text in a Grid
• Advanced Grid Filters
• Grid Manager
• Using PickLists
• Claims

2.1 Open an AVEVA Instrumentation Project
When an AVEVA Instrumentation module is started, the Select an AVEVA Electrical
Project window is displayed, from which the required project can be selected. refer to the
Common Functionality User Guide for details.

2.2 Instrument Designer Tabs
On opening, the Designer module displays four tabs: Project, Home, Manage and View.
Once a grid is opened, an additional "List Tools" tab, named after that grid and containing
commands specific to that grid, is displayed (if there are any).

The rest of this section describes those tab options specific to Designer.

For details of options common to all Instrumentation modules, refer to the Common
Functionality User Guide. 

2.2.1 Project Tab
The Project tab includes the following Designer-specific options:

Setup Sub Menu:

Loop Titles (Import 
format)

Displays the Loop Import Drawing Titles Settings window.
Refer to Drawing Title Setup Preferences. 

Termination Titles 
(Import format)

Displays the Termination Import Drawing Titles Settings
window. Refer to Drawing Title Setup Preferences.

Enhanced Cable Block 
Diagrams Titles 
(Import Format)

Displays the Enhanced Cable Block Diagrams Import
Drawing Titles Settings window. Refer to Drawing Title
Setup Preferences. 

Set Export File Name/
Folders

Displays the File Export Settings window. Refer to Export
Drawings to Pre-Defined Folders with File Names in a Pre-
Defined Format

Drawings Export to 
External System 
Configuration

Displays the Export to External System Configuration
window. Refer to Drawing Publishing.
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2.2.2 Home Tab
The following Designer-specific options are accessed from the Select option in the Lists
and Schedules section:

Under the List heading:

Under the Catalogue heading: 

2.2.3 Manage Tab
The Manage tab includes the following Designer-specific options:

In the Integration section:

In the Import section:

2.2.4 View Tab
All options on the View tab are common to all AVEVA Instrumentation modules.

Drawing List Displays the Drawing List grid view.

Template List Displays the Template window showing all project Template files,
which may then be opened in AutoCAD. Refer to Open a Template
Drawing with AutoCAD.

Hookup 
Drawing List

Displays the Hookup Drawings List grid view showing only hookup
drawings and hookup specific commands. Refer to Hookups.

Seeds Displays the Seeds grid view. Refer to Seeds List.

CBD Seeds Displays the CBD Seeds grid view. Refer to Enhanced Cable Block
Diagram Seeds List.

Reports Display the Reports grid, showing Designer-specific reports. Refer to
Reports.

Hookup 
Catalogue

Displays the Hookup Catalogue grid view. Refer to Hookups
Template Catalogue.

Hookup Items 
Catalogue

Displays the Hookup Items Catalogue grid view.

Publish to AVEVA 
NET

Used to export data to AVEVA NET. Refer to Export to AVEVA
NET.

From Other Project Used to import Hookup drawing templates and Hookup
catalogue items from another Instrumentation project. Refer to
Import Hookup Catalogue
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2.2.5 List Tools Tab
The List Tools tab contains options specific to the grid which is currently being viewed. If no
grid is open, or if the current grid has no grid-specific options, the tab will not be displayed.

The name of the tab will be the name of the current grid.

For details of the options on this tab, refer to the appropriate grid topic.

2.3 Select a Language
If required, a different language can be selected. For a description of this functionality, refer
to the Common Functionality User Guide.

2.4 Select a Colour Scheme
If required, a different colour scheme can be selected. For a description of this functionality,
refer to the Common Functionality User Guide.

2.5 Working with the Data Grid
For a description of the generic functionality of the Data Grid used in all AVEVA
Instrumentation applications, refer to the Common Functionality User Guide.

2.6 Finding and Replacing Text in a Grid
Any text string within a grid can be found, highlighted and optionally replaced. For a
description of this functionality, refer to the Common Functionality User Guide.

2.7 Advanced Grid Filters
Advanced (complex) filters can be applied to a grid. For a description of this functionality,
refer to the Common Functionality User Guide.

2.8 Grid Manager
The Grid Manager allows users to define their own sets of data fields (columns), default
column orders, default sorting and predefined data filters for most grids. For a description of
this functionality, refer to the Common Functionality User Guide.

2.9 Using PickLists 
Many grid cells and window fields can be, or must be, completed by selecting from lists of
values. These “Pick Lists” can be edited if required. For a description of this functionality,
refer to the Common Functionality User Guide.
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2.10 Claims
If a user attempts to edit an item which is currently being edited by another item, a message
is displayed to inform the user that the item is locked. For details of how to unlock claims,
refer to the Common Functionality User Guide.
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3 Options

The Options window is used to view and edit preferences for drawings generated by
Designer. To open the Options window, select Options from the Project tab. 

The window includes five tabs. Continue at:
• General Tab
• Revisions Tab
• Rev Clouds Tab
• Terminations Tab
• Enhanced Cable Block Diagrams Tab
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3.1 General Tab

From the AutoCAD Drawing Units list, select Metric (mm) or Imperial (inch).

Enter the default snap value in the Default Snap value field.

Note: The Log Changes checkbox is not currently used.

In changes to drawings are to be automatically highlighted by clouds, check Cloud
Changes. The appearance and other preferences for clouds are specified on the Rev
Clouds tab (see below).

Enter the drawing layer to be used for drawing borders in the Drawing Border layer field.

If loop sheet numbers are to be ignored on termination diagrams, check Ignore Loop Sheet
Nos on Termination Diagrams.

Enter the number of characters to be used for sheet numbers in file names in the Length of
Sheet No in Filename field.
12 Series3:2© Copyright 2000 to current year.
AVEVA Solutions Limited and its subsidiaries. 
All rights reserved.



Instrument Designer User Guide
Options
3.2 Revisions Tab

Enter the maximum numbers of loop, termination and hookup revisions that are to be listed
on drawings in the fields provided.

In the Name Captions section of the tab, specify which details are to be displayed for each
drawing revision (e.g. By, Checked, Approved etc) by checking the appropriate checkbox. 

If the caption for a revision detail is to be other than the default caption, enter the required
caption in the field provided. For example, if "Reviewed" is to be used instead of "Checked",
enter "Reviewed" in the Caption field for the Checked caption.
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3.3 Rev Clouds Tab

Changes to drawings are automatically highlighted using revision clouds if the Cloud
Changes checkbox on the General tab (see above) is checked.

Enter the drawing layer to be used for revision clouds in the Drawing Border layer field.

Select the colour of clouds from the Color for Clouds list.

If clouds are always to be plotted, check Always Plot Clouds.

If clouds are always to be shown, check Always Show Clouds.

Enter the width, ratio and offset of the cloud bulges in the Cloud Parameter fields.
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3.4 Terminations Tab

In the fields provided, enter: 
• The heights of terminal strip marking text, terminal marking text and core/wire number

text.
• The widths of devices, device terminals, I/O modules, I/O module terminals, cable

numbers, OAS screens and group screens.
• The lengths of cables and the minimum lengths of cores and wires.

Note: The Cable No Width value is to break the cable line. It does not define the actual
block width. To change the Cable No block width the block, the Cable No Offset
must be redefined (see below). 

Other Parameters
• In the Cable Spacing field enter the horizontal distance between cables when more

than one cable is drawn to the same terminal strip when cables are being drawn
vertically 
12 Series3:5© Copyright 2000 to current year.
AVEVA Solutions Limited and its subsidiaries. 
All rights reserved.



Instrument Designer User Guide
Options
• In the Cable No Offset field, enter the vertical distance from the centre of the Cable No
block to the cable. The default zero (0) places the Cable No within the cable.

• In the Caption for ‘TO’ field enter the text to be used as the caption before other “off-
sheet” drawling numbers referred to on Termination diagrams, e.g. ‘TO’ (the default), or
‘REFER’.

• If ferrule numbers are to be included by default on Termination diagrams instead of
signal numbers, ensure that the Show Ferrule Numbers on Termination Diagrams
checkbox is checked (it is checked by default). Note that whether or not ferrule
numbers are shown can be overridden for individual diagrams. 

• If ferrule numbers are to be shown (see the above settings), and are to be placed
“inside” wires, check Draw Ferrule Nos 'Inside' Wire. If this is not checked then ferrule
numbers are drawn above the wires.

• If core markings are to be placed outside of wire numbers, check Draw Core Marking
on 'Outside'. If checked, core markings are drawn to the right side of wire numbers for
wires drawn from the right side of a terminal, and to the left for wires drawn from the left
side.

• If intermediate junction box connections are to be included on Termination diagrams,
ensure that the Show Intermediate Junction Box Connections on Termination
Diagrams checkbox is checked (two levels of marshalling on the left hand side of the
primary junction box terminal strips may be displayed on Termination diagrams and
Enhanced Termination Reports). Note that whether or not intermediate junction box
connections are shown can be overridden for individual diagrams.

• The Draw Looping Wire with Bend checkbox controls how looping wires are drawn
on Termination diagrams. If the checkbox is checked, looping wires will be drawn like
this, with an extra bend:

If the checkbox is unchecked, they will be drawn with the extra bend:
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• In the Cable Connector Gap (prevent overlap) field, enter the horizontal distance
between parallel cables that are drawn vertically on Termination diagrams.The default
value is 3.

• If the markings of cable cores do not include group numbers (only their colours), they
may instead be identified on Termination diagrams using their core group numbers.
Ensure that the Show Core Group No’s on Termination Diagrams checkbox is
checked if this is required. Note that whether or not core group numbers are shown can
be overridden for individual diagrams.
Group numbers will be displayed with a prefix that depends on the group type: Pr for
Pairs, Tr for Triads and Qd for Quads. For the Cores (single wire) group type there will
be no prefix.

• If a cable is connected to an instrument that has a Loop diagram generated for it, the
Loop diagram numbers may be displayed on Termination diagrams. If this is required,
ensure the Show Loop Diagram Number checkbox (the default setting) is checked.

The following example illustrates how the basic parameters are applied to a termination
drawings:
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Wire Destination References

Checking either the Use DwgNo. References for Wires or the Use Sheet References for
Wires checkboxes activates the Prefix and Suffix list which enables the user to enter their
own prefix or suffix.

Checking the Use DwgNo. References for Wires checkbox also activates the Drawing No.
list. The drop-down list has the following options:

Use Dwg No. Default option which uses the drawing number shown in the
DwgNo column on the Drawing List grid view.

Use Client Dwg No Users that want to use their own drawing number instead of
the AVEVA Instrumentation number can select this option
which uses the drawing number shown in the ClientDwgNo
column on the Drawing List grid view.
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Checking the Use Sheet References for Wires checkbox activates the Sheet No. Prefix
list, enabling users to change the word used to prefix the Sheet No., for example Sheet,
SHEET or SHT.

The user can check both the Use DwgNo. References for Wires and the Use Sheet
References for Wires checkboxes enabling the user to add a Drawing No. and a Sheet
No. Prefix.

Text Styles/Fonts Definition

AVEVA Instrumentation draws all Wire/Ferrule Nos and reference text in the Seed File
Drawing's current text style. By setting the current text style in the Seed Drawing File(s) the
final text style (font) can be user defined.

Line Weights/Line Colours Definition

AVEVA Instrumentation uses three predefined layers to draw the graphics. Layer colours to
and line weights may be changed to client standards if required in the Seed Drawing File(s)
used to generate termination diagrams.

Layers used are:

Cable Number Block Definition

AVEVA Instrumentation uses a Cable Number block named 'CableNo' which is inserted into
the drawing for each cable number. The Cable Number block can be redefined to change its
appearance (for example, change text height, use rounded ends or make longer etc.). The
block should be defined with a single attribute and redefined within each Seed Drawing File
used by AVEVA Instrumentation for the project. 

L2 Default colour is White. This is the Layer associated with a 0.25mm pen width
and 2.5mm text height.

L3 Default colour is Yellow. This is the Layer associated with a 0.35mm pen width
and 3.5mm text height.

L5 Default colour is Red. This is the Layer associated with a 0.5mm pen width and
5mm text height.
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If AVEVA Instrumentation does not find a block named 'CableNo', it is inserted from a file
named AVEVA InstrumentationTermDefaults (or AVEVA
InstrumentationTermDefaultsImperial if using non-metric settings) located in the
'DwgExamples\Seeds' folder in the AVEVA Instrumentation program files folder. Opening
AVEVA InstrumentationTermDefaults (or AVEVA InstrumentationTermDefaultsImperial) and
redefining the Block 'CableNo' will affect all termination drawings where the Seed file does
not contain any 'CableNo' block reference.

Device and I/O Module Description Text

In the Device and I/O Module Catalogues in Wiring Manager, the Description on Drawing
field can be used to change the default drawing description to the value entered in that field.
Using the <Enter> key will add a line-break in the drawing to create multiple lines of text. Up
to three lines will be created for the description in both AutoCAD termination diagrams
created in Designer and Termination PDF reports created in Wiring Manager. If the
Catalogue Definition Description on Drawing field is left empty the default description will
be used which is a concatenation of the Manufacturer and Model No., separated by a space.

3.5 Enhanced Cable Block Diagrams Tab
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If layers are to be utilised in distribution diagrams, check the Use Layers checkbox. In the
fields below the checkbox, specify which layers are to be used for equipment, and for links
and cables.

Note: Ensure that the entered layers correspond to the appropriate layers in the seed files,
as set up using the Seeds List.

Click Save to exit the Options window and save changes made to preferences.

Click Cancel to exit the window without saving changes.
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4 Areas

All engineering items in AVEVA Instrumentation must be assigned to a Plant Area. The first
task once the project is setup (refer to the Installation User Guide for further information on
project setup), is to add areas to the project database. 

For a description of this functionality, refer to the Common Functionality User Guide.
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5 Drawing List

The Drawing List is the Instrument Designer window for adding/editing and accessing
drawings. By default all drawings for the project are shown in the grid, however the user can
filter the data by using the column 'on-the-fly' filters, the advanced filter window or by
creating new grid views containing user-defined sets of columns using the Grid Manager.

Note: Hookup drawings are created using a separate facility. See Hookups.

To open the Drawing List, click Select in the Grids and Schedules section of the Home
tab.

Select Drawings from the list of grids that is then displayed. The Drawing List grid is then
displayed:

Note: Refer to Working with the Data Grid for information on the grid control including how
to select a record (a Drawing).

The grid provides details on each project drawing, including Drawing Number, Loop No (if a
Loop Diagram), Title, Current Revision, Equipment No (if a Termination Diagram) and dates/
times for Last Updated, Last Printed etc.

Mandatory Data

To produce a drawing, a drawing number and sheet number must be entered. Designer
uses these to create a file name. For example: Drawing No: 123456 and Sheet No: 1 are
combined to create a file name: 123456-1.dwg.

Special Grid Features

Some cells within the grid will display a small button in the right side of the cell when the
mouse cursor is hovered over it. Additional information related to the cell's instrument and
cell name can be accessed from these button. These cells are:

• Loop No: Selecting the Loop No cell button displays the Options window, used to
view/edit Loop data, as described in Loop Data.
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• Equipment No: Selecting the Equipment No cell button enables users to view/edit the
associated Equipment and terminations, using Wiring Manager facilities. See
Equipment Data.

• Segment Name: Selecting the Segment Name cell button displays the Fieldbus
Segments Diagrams window, in which details of the associated segment (if there is
one), can be viewed and edited. Refer to the Wiring Manager User Guide for details.

Auto Generation of Drawings

AVEVA Instrumentation uses special 'DataLinks' to map database data to AutoCAD drawing
attributes. DataLinks are automatically updated by Designer when a drawing is opened or
updated from the Drawing List. For information on using Designer's DataLinks to update:
Drawing Title Block (Drawing Border) - including revisions history, Loop Diagram technical
data (tag, cable, wire numbers, terminal markings etc) or to generate Termination Diagrams
refer to Drawing Generation.

Drawing List - List Tools Options

The following options are located on the List Tools - Drawings tab:

Records Section

Refresh

These common options are also located on the Home tab.
Refer to the Common Functionality User Guide for details.

New

Edit

Delete

Actions Section

Open Opens the selected drawing for reviewing/printing etc in AutoCAD
(editing title block and revision information should be done from the Edit
button on the Home tab) (refer to Issues when Opening AutoCAD
Drawings).

Update Creates or updates selected drawing(s) in AutoCAD - DataLinks in each
CAD drawing are updated with current project data from the AVEVA
Instrumentation database. Refer to Create or Update Drawings for
details.

Note: If the drawing file does not exist, the file is created by copying a) the template file
(if drawing uses a template drawing) or b) the seed file (if drawing uses a seed
drawing). Refer to the Drawing Generation for more information.

Issue Issues and updates selected drawing(s). Refer to Drawing Issues.

Open Issues 
For Selected

Displays the Issues window listing all the current issues for the selected
drawing. Refer to View Previous Issues for further information.

Open Issues 
For All

Displays the Issues window. Refer to View Previous Issues for further
information.

Revisions Displays a list of all drawings with revisions (and their revisions). Refer
to Viewing and Editing Multiple Document Revisions. 
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Add
Revisions

Used to create a new revision. Refer to Create a Revision.

Edit
Revisions

Used to edit the current revision. Refer to Edit a Revision.

Check for 
New Loops

Checks for new Loop drawings created in the Engineer module and
imports them into the Drawing List. Refer to Import Drawings into the
Drawing List.

Check for
new CBD

Checks for new Enhanced Cable Block diagrams created in the Wiring
Manager module and adds them to the Drawing List. Refer to Import
Drawings into the Drawing List.

Check for 
New 
Terminations

Checks for new Termination drawings created in the Wiring Manager
module and imports them into the Drawing List. Refer to Import
Drawings into the Drawing List.

External Ref 
Drawing Nos.

Used to view, add and edit list of non-AVEVA Instrumentation
Termination Drawing numbers for equipment. Refer to Non-AI
Termination Drawing References.

Highlight 
Documents 
for Reissue

Used to highlight which issued drawings include data that has been
changed in the database and therefore should be updated and
reissued. Refer to Highlight Drawings for Reissue.

Tools Section

Show 
Datalinks

Used to view the list of DataLinks for a selected drawing. Refer to
DataLinks Window.

Rename Used to rename batches of selected drawings. Refer to Rename
Selected Drawings.

Printing Section

Print Prints selected drawing(s).

Export Section

To External 
System

Publishes selected drawings to a folder. Refer to Drawing Publishing.

Selected 
Drawings Used to export selected drawings files in the following ways:

Copy/Archive 
to Folder

Used to export drawing files to a folder defined during
the export process. Refer to Export Drawings to a
Specified Folder.

Copy to User 
Defined 
Names

Used to export drawing files to a pre-defined folder or
folders with file names in a pre-defined, user-defined
format. Refer to Export Drawings to Pre-Defined
Folders with File Names in a Pre-Defined Format.
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5.1 Add a New Drawing
This topic describes how to manually add drawings to the Instrument Designer's Drawing
List.

Important: Drawings can also be added to the drawing list by checking Engineer and
Wiring Manager for any new diagrams that may be required.
Any new loops that have been marked as 'Drawing Required' can be imported
in Engineer into the Drawing List as a Loop Diagram.
Any equipment added that has been marked as ‘Termination Dwg Required' in
Engineer can be imported into the Drawing List as a Termination Diagram.
Any new Enhanced Cable Block Diagrams in Wiring Manager can be imported
into the Drawing List.
Refer to Import Drawings into the Drawing List.

Note: These methods are the preferred way to populate the Drawing List as they
automatically create the new Drawing List entry, assign the Drawing Type and
populate the drawing titles based on the engineering data. The drawing title formats
used can be user-defined in the drawing title setup preferences windows (refer to
Drawing Title Setup Preferences).

Note: Loop diagrams can also be added to the drawing list using facilities available from
the Loop Check Report feature in Engineer.
Termination diagrams can also be added to the drawing list using facilities available
from the Enhanced Termination Report feature in Wiring Manager.

With the Drawing List open, click New on the Home tab to display the Drawing Information
window:
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Note: Existing drawing entries can be copied to create a new drawing record in the
Drawing List by selecting an existing record, then using the Copy Selected
command in the drop-down menu next to New on the Home tab.

Note: All of the data entry fields in this Drawing Information window can automatically
update each drawing by using DataLinks to link the database data to drawing
attributes.

Continue at:
• Drawing Information Overview
• Drawing Information Tabs

5.1.1 Drawing Information Overview
The Drawing No and Sheet No fields are used to create the drawing filename and must be
completed with a unique combination of drawing number and sheet number. The filename is
always DrawingNo + '-' + SheetNo (e.g XXXXX-1). Every drawing should also have either a
Template or a Seed file associated with it.

Enter a number in the Index Sheet Order field to specify the order in which the drawing will
be listed on Index Sheet type drawings (from lowest to highest). The number must be
unique for the drawing number. 

Note: If there is a value of -1 in an Index Sheet Order field, this indicates that the drawing
was upgraded as part of an older project without the Index Sheet drawing
functionality. Such drawings will be ignored by Index Sheets. The user may replace
any -1 values with positive Index Sheet numbers as required.

Select a Plant Area from the Plant Area field.

Select the drawing type from the list provided: Cover Sheet, Index Sheet, Notes Sheet,
Reference Drawing Sheet, Loop Diagram, Segment Check Report, Loop Check Report,
Enhanced Termination Report, Termination Diagram, Enhanced Cable Block Diagram, and
Other.

Note: For Cover Sheet, Index Sheet, Notes Sheet and Reference Drawing Sheet drawing
types, the sheet number can be either a letter, or a number, or a combination. For
other drawing types, it must be a number. 
Refer to Cover, Index, Notes and Reference Drawing Sheet Drawing Types for
details of these drawing types.

• For all drawing types except the Enhanced Cable Block Diagram drawing type, the
Template drop-down list shows a list of all templates drawings created for the current
project (all drawings in the Project Template directory). Select the required template.

• For all drawing types except the Enhanced Cable Block Diagram drawing type, the
Seed drop-down list shows a list of all Seed drawings created for the current project (all
drawings in the Project Seed directory). Select the required seed drawing (refer to
Seeds List for details of seeds). 
In the case of Enhanced Cable Block Diagrams, the Seed drop-down list shows a
different list of ECBD-specific seeds (refer to Enhanced Cable Block Diagram Seeds
List for details). 

• If the Loop Diagram or Loop Check Report types are selected, the Loop No. drop-
down list becomes active. Select the loop that the drawing is associated with. See
below for details.
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• If the Segment Check Report type is selected, the Segment Name drop-down list
becomes active. Select the name of the associated segment in Wiring Manager. See
below for details.

• If the Termination Diagram or Enhanced Termination Report types are selected, the
Equipment No. drop-down list becomes active. Select the equipment that the drawing
is associated with. See below for details.

• If the Termination Diagram drawing type is selected, the Show Ferrule Numbers
checkbox is displayed. If ferrule numbers are to be displayed on the diagram instead of
signal numbers, ensure that this checkbox is checked. The default setting for this
checkbox is set on the Terminations Tab of the Options window.

• If the Termination Diagram drawing type is selected, the Show Intermediate Junction
Box Connections checkbox is displayed. If intermediate junction box connections are
to be included on the diagram, ensure this checkbox is checked (two levels of
marshalling on the left hand side of the primary junction box terminal strips may be
displayed on Termination diagrams). The default setting for this checkbox is set on the
Terminations Tab of the Options window.

• If the Termination Diagram drawing type is selected, the Show Cable Core Group
No’s checkbox is displayed. If cable core group numbers are to be displayed on the
diagram, ensure that this checkbox is checked. The default setting for this checkbox is
set on the Terminations Tab of the Options window.

• If the Enhanced Cable Block Diagram drawing type is selected, the CBD Name drop-
down list becomes active. The list consist of the Enhanced Cable Block Diagram
drawings in Wiring Manager. Select the ECBD that the new drawing is to be linked to in
Designer.

Select a Loop

To select a loop number, click the button in the Loop No field to display the Assign
Drawing to Loop window:

Select the required loop from the list and click Assign, or double-click on it.
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Refer to Engineer documentation for more details of the Select Equipment window.

Note: It is possible to create a multiple drawing sheet loop diagram by creating multiple
records in the Drawing List (each with a different sheet number). Users can assign a
different Template to each drawing if required.

Select a Segment

A segment must be selected when a Segment Check Report is created.

To select a segment name, click the button in the Segment Name field to display the Select
Segment window:

Select the required segment from the list and click Select, or double-click on it.

Refer to Wiring Manager documentation for more details of the Select Equipment window.

Select Equipment

To select an equipment number, click the button in the Equipment No field to display the
Select Equipment window:
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Select the required equipment from the list and click Select, or double-click on it.

Different items of equipment can be selected for drawings with the same drawing number.
There is no requirement that all drawings with the same drawing number are associated
with the same equipment.

Note: If the selected equipment has more terminations than can fit on a single drawing
sheet, additional drawings sheets will be created automatically as required when the
drawing is generated using the Update command. Refer to Create or Update
Drawings for further details.

Refer to Wiring Manager documentation for more details of the Select Equipment window.

5.1.2 Drawing Information Tabs

Drawing Author Information

The Author(s) tab is used to record the identities of the drawing author, designer, checker
and approver, and when these activities were completed.
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The tab is also used to specify the design status and enter and alternate document number
and work pack number if required.

Drawing Title

The Title tab is used to enter the drawing title, as it will appear on the drawing itself, plus
remarks on the drawing.

Revision History

The Revision History list (in the Revisions tab) shows all revisions for the current drawing:
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Revisions Tab Buttons

Drawing Notes

The user can add notes to the drawing in the Notes tab.

Add Used to add a new revision to the current drawing using the
Revision Entry window. Refer to Drawing Revisions for more
information.

Note: Adding a new Revision changes the Current Revision of the
drawing in the Drawing List to the new Revision Number.

Note: Revisions may also be added to multiple drawings in one
command. For information on this feature refer to Viewing
and Editing Multiple Document Revisions.

Edit Used to edit a selected drawing revision using the Revision Entry
window. Refer to Drawing Revisions for more information.

Note: Double-clicking on any existing Revision will also bring up
the Revision Entry window.

Delete Enables the deletion of the currently selected revision.

Note: Pressing the Delete button will also delete the currently
selected revision.
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Reference Drawings

The Reference Dwgs tab enables a user to add manual drawing references for the current
drawing:

User Fields

The User Fields tab is used to enter any additional project or user-specific information on
the drawing in the six fields provided.
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5.2 Cover, Index, Notes and Reference Drawing Sheet 
Drawing Types
These drawing types are used to present information about multiple drawings, i.e. “bundle”
all with the same drawing number.

For example, an item may posses to many terminations to be displayed on a single
Termination Diagram. Multiple Termination Diagrams must therefore be used to displayed
them. Each of these drawings will have the same drawing number, and a unique sheet
number. Alternately, a “bundle” of drawings with the same drawing number may be created
for associated equipment items.

Cover, Index, Notes and Reference Drawing Sheet drawings can be generated to
accompany these drawings, so as to provide:

• A Cover Sheet, displaying general information regarding the drawings. The Cover
Sheet, when created, will display the data entered in its Author(s), Title and Revisions
tabs (see Drawing Information Tabs), and general drawing and project information
(area, project number etc.).

• An Index Sheet, display the content of the drawing “bundle”, i.e. a list of the drawings in
it. An Index Sheet will display all drawings with the same drawing numbers as it. The
order they are listed in is controlled by their Index Sheet Order number, as entered into
the field of the same name (see Drawing Information Overview).

• A Notes Sheet, displaying any general additional information regarding the drawings.
This will display the information entered in its Notes tab (see Drawing Information
Tabs). 

• A Reference Drawings sheet, listing associated drawings and documentation. This will
display the information entered in its Reference Dwgs tab (see Drawing Information
Tabs).

Cover, Notes and Reference Drawing Sheet drawings can be used for drawing bundles
consisting of drawings with different drawing numbers, and may themselves have different
drawing numbers. If they have the same drawing number, they must have a unique sheet
number. As described above, Index Sheet drawings must have the same drawing number
as the drawings they list.

For Cover Sheet, Index Sheet, Notes Sheet and Reference Drawing Sheet drawing types,
the sheet number can be either a letter, or a number, or a combination. For other drawing
types, it must be a number.
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Note: In order for these drawing types to display sheet numbers with letters, on their
templates the sheet number attribute must be mapped to the {Sheet} datalink (and
not {SHT} as in most templates). Refer to Assign DataLinks in AutoCAD for details.

Example information on Index Sheet drawing:

Note: The index sheet order number is allocated to the index sheet order datalink values of
drawings of the Index Sheet drawing type. Changing one will change the other.

5.3 View and Edit Drawing Information
To view and edit existing drawing information, select the drawing in the Drawing List and
click Edit on the Home tab, or double-click on the drawing record in the Drawing List. The
Drawing Information window is then displayed.

Note: All of the data entry fields in the Drawing Information window can be automatically
updated for each drawing by using DataLinks to link the database data to drawing
attributes.
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Note: The Last Edit field displays the date and time when the drawing data was last
edited. The user name of the individual that performed the edit is displayed in a tool-
tip when the mouse cursor is hovered over the field. Click the button in the field to
display the Audit Manager, which will display a list of all the changes to the drawing
data.

Refer to Add a New Drawing for further details of this window.

5.4 Rename Selected Drawings
This facility enables the user to rename drawings in batches.

Select the items to be renamed in the Drawing List grid view and then click Rename on the
List Tools - Drawings tab to display the Batch Drawing Rename window.

The user must enter a value into the Number field. The value can be numbers, letters or a
combination of the two. If the user enters any letters the Increment checkbox next to the
Number field cannot be used. If only numbers are entered, the user may check the
Increment box. This causes the Drawing Numbers of the selected items to be incremented
by one.

The user must choose between using the existing sheet numbers by checking Use Current
Sheet Number box or to enter a new value in the Sheet No field. Using the Sheet No field
enables the user to check the Increment checkbox to increment the sheet numbers by one.
If neither option is used, a message is displayed requesting the user make a choice.
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The Prefix and Suffix fields can optionally be used to add prefixes and suffixes to drawing
numbers. They can be numbers, letters or a combination of the two. If the user enters any
letters in the Suffix field the Increment checkbox cannot be used.

This checkbox can be used to set the suffix to be incremented instead of the drawing
number. If the drawing number is set to be incremented, the suffix cannot be set to be
incremented, and vice versa.

When values are entered, a preview of the new drawing number is displayed under the
Suffix field.

When the required fields have been completed the user must click OK to accept the values
and display the Select Drawings for Renaming window or click Cancel to close the Batch
Drawing Rename window and return to the grid view.

If the new number already exists the Duplicate Drawing Numbers window is displayed
warning the user that the number cannot be used. 
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Click Close to close the Duplicate Drawing Numbers window and return to the grid view
without renaming the file(s).

If there are no duplicate drawing numbers, the Select Drawings for Renaming window is
then displayed. This lists all the drawings selected in the grid view and displays the Old
Drawing No, Old Sheet No, New Drawing No and the New Sheet No.
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The user can select individual drawings to be renamed by clicking the appropriate
checkboxes. To select all the drawings the user can click Select All to check all the boxes.

Clicking Cancel closes the Select Drawings for Renaming window and returns the user
back to the Batch Drawing Rename window.

After selecting the required drawings, clicking Rename Drawings displays the Renamed
Drawing Log window which displays the status of the renamed drawings.
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Click Close to close the Renamed Drawings Log window and return to the grid view which
refreshes to display the new drawing names.

5.5 Delete Drawings
To delete a drawing, select it from the list and click Delete on the Home tab. The Drawing
Delete Options window is then displayed:

• Click Delete from Drawing List if the drawing is to be deleted from the list, but the
drawing file is not be deleted.
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• Click Delete Drawing File Only if the drawing file is to be deleted, but not the record in
the drawing list.

• Click Delete from Drawing List and Drawing File if both the drawing record in the list
and the associated drawing file are to be deleted.

After selecting from the above options, click Delete to complete the deletion.

Note: The drawing sheet and index sheet order numbers of subsequent drawing sheets
with the same drawing number as the deleted sheet will be automatically updated (i.e
decremented) when the drawing is updated (refer to Create or Update Drawings for
details).

Note: For termination diagram drawings, if the equipment has more terminations than can
fit on a single drawing sheet, additional drawings sheets will be created automatically
as required when the drawing is updated. If such a sheet is deleted, it will
automatically be created again when the drawing is updated, unless the underlying
termination data is amended so that this sheet is no longer required.

5.6 Drawing Title Setup Preferences
Designer provides facilities for the importing of loop diagram, termination diagram and
enhanced cable block diagram drawing records from other AVEVA Instrumentation
applications as described in Import Drawings into the Drawing List.

AVEVA Instrumentation enables users to define how the drawing titles will be created based
on values assigned to the loop or equipment engineering data.

To Define Imported Diagram Drawing Titles

From the Project tab, click Setup, then click either Loop Titles (Import format),
Termination Titles (Import format) or Enhanced Cable Block Diagrams Titles (Import
format) as required. The appropriate Import Drawing Title Settings window is then
displayed (for example):

The window contains three fields that defines each of the Drawing List's title data fields.
Each title can contain a mixture of text and DataLinks. On importing a new loop diagram
from Engineer's Loop List, AVEVA Instrumentation will replace the DataLinks with the value
for the database field within the DataLink. For example: Title 1 above is defined as: AREA
{AreaNo}. When checking for new loops, if AVEVA Instrumentation found a new loop in area
21 then Title 1 would be: AREA 21.

To edit each import title, open the field on the right of Title field for the desired title field.
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To select a DataLink, check the appropriate checkbox in the field for the DataLink(s)
required.

AVEVA Instrumentation will add the selected DataLink to the Title field.

The Title field can be edited manually, text added or deleted as required.

Use Save to save the title format.

5.7 Import Drawings into the Drawing List
Loop diagram, enhanced cable block diagram and termination diagram drawing records
may be imported from other AVEVA Instrumentation applications and from Excel:

To check Wiring Manager and Engineer for drawings:

As required, click Check for New Loops, Check for New CBDs, or Check for New
Terminations on the List Tools - Drawings tab.

Note: If drawing numbers contain special characters such as <, >, ?, * etc. they will not be
imported. A message is displayed to inform the user of this when any of the above
options is selected.

The Drawing Check Options window is then displayed (for example):

Select the required option or options:
• If the Check For New option is selected, new diagrams of the appropriate type will be

added to the Drawing List for each new equipment, loop or enhanced cable block
diagram found in Wiring Manager or Engineer.

Drawing Type Application From

Loop Diagrams Engineer When the Drawing Required option is
selected in the Loop List (or Loop Detail
window)

Termination Diagrams Wiring Manager When the Dwg Required option is selected
in the Equipment List (or Equipment Detail
window)

Enhanced Cable Block
Diagrams

Wiring Manager The Cable Block Diagrams list.
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• If the Check and Update Existing option is selected, details of equipment, loops or
diagrams that already have drawings in the Drawing List are checked, and the details in
the Drawing List are updated if changes are detected.

• If the Check for Deleted option is checked, diagrams for any equipment, loops or
diagrams that has been deleted from Wiring Manager or Engineer will be removed from
the Drawing List.

Click Check.

The appropriate list is then checked for new, updated and/or deleted equipment, loops or
enhanced cable block diagrams depending on the option(s) specified.

A Progress window displays the progress of the check (for example):

When the procedure is completed, the number of added, changed and/or deleted drawings
is displayed (for example):

If deleted equipment, loops or diagrams are detected, the user will be asked to confirm the
deletion of the relevant drawing from the Drawing List. For example:

Titles of new drawings in the Drawing List will be created based on values assigned to the
equipment engineering data, according to configuration rules defined by users. Refer to
Drawing Title Setup Preferences for details.
12 Series5:21© Copyright 2000 to current year.
AVEVA Solutions Limited and its subsidiaries. 
All rights reserved.



Instrument Designer User Guide
Drawing List
5.7.1 Importing from Excel
Drawings can also be imported from an Excel spreadsheet. 

For a description of this functionality, refer to the Common Functionality User Guide.

5.8 Create or Update Drawings
To create or update selected drawings and trigger DataLinks in each CAD drawing to be
updated with current project data from the AVEVA Instrumentation database, select the
drawing(s) in the Drawing List and click Update on the List Tools - Drawings tab.

Note: In the case of termination diagrams, if the selected equipment has more terminations
than can fit on a single drawing sheet, additional drawing sheets will be created
automatically as required when the drawing is created or updated during this
procedure. See Termination Diagrams for further details. 

Each selected drawing is then opened in AutoCAD (refer to Issues when Opening AutoCAD
Drawings). The Update Options window is displayed:

The window is used to specify whether or not the drawings are to exported when they are
saved, whether or not changes in the drawing are to be highlighted with revision clouds, and
whether or not the drawings are to be plotted when they are saved.

If the export option is selected, the drawings are exported to a pre-defined folder or folders
with file names in a pre-defined, user-defined format. The folder(s) and the file name format
are specified using facilities accessed from the Setup menu on the Project tab. Refer to
Export Drawings to Pre-Defined Folders with File Names in a Pre-Defined Format for
details.
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Issues when Opening AutoCAD Drawings

When attempting to open an AutoCAD template, from within AVEVA Instrumentation the
following message may be received:

Error Decrypting Data

This is caused by the fact that the original drawing was created by an application that is not
trusted by AutoCAD. To bypass this problem the following action should be completed:

1. Open the drawing in native AutoCAD.
2. At the command line enter: Dwgcheck.
3. Enter a new value = 0.
4. Save the drawing.

This will prevent this error occurring.

5.9 Drawing Revisions
Revisions can be assigned to drawings. Each revision has a unique identifier, and is
assigned a date. Other details such as a description and details of the individuals that
created, checked and approved the revision may also be specified.

Continue at:
• Create a Revision
• Edit a Revision
• Viewing and Editing Multiple Document Revisions

5.9.1 Create a Revision
To create a revision for a drawing or drawings, select the drawing(s) in the Drawing List,
then click Add Revision on the List Tools - Drawings tab. The Revision Entry window is
then displayed:

If a single drawing was selected, enter the new revision number in the Revision No field.

If multiple drawings were selected, a different version of the window is displayed:
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Either enter a revision number in the Revision No field to be applied to all the selected
drawings, or click the Auto Increment checkbox (this is not available when editing multiple
revisions, only when creating). The Revision No field is then disabled. When Save is
clicked, all the revision numbers of the selected drawings are incremented by one, e.g. if the
current revision is “A”, then the next is “B” or if current revision is “2”, then the next is “3” etc.

Double-click on the Date field to open a date selection form (or press the Enter key when
the Date field is selected).

The Description field contains a list of all previously created revision descriptions. Add a
new description by entering it in the field. Any new descriptions will be available for future
revisions.

Note: Which fields appear on this window (apart from the Revision No, Date and
Description fields) and their names is specified on the Revision tab of the Options
window. See Revisions Tab.

5.9.2 Edit a Revision
To edit the current revision of a drawing or drawings, select the drawing(s) and click Edit
Revision on the List Tools - Drawings tab. 

If a single drawing was selected, the Revision Entry window is then displayed with the
details of the current revision displayed for editing.
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If multiple drawings were selected, the window will be blank except for the Date field. 

Refer to Create a Revision for details.

5.9.3 Viewing and Editing Multiple Document Revisions
To view a list of all revisions of all drawings, click Revisions on the List Tools - Drawings
tab. The Revisions window is displayed:

To view the revisions for a single drawing click on the + icon next to its listing.
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To view revisions for all drawings, click Show All Revs. 

To edit an existing revision click Edit. The Multi-Field Edit (Bulk Edit) window is displayed. 

• To edit a revision field, check the appropriate checkbox and enter the new value. 
• Click Select all to select all fields for editing. 
• Click Copy first record's data to copy the values for the revision first selected in the

Revision window into the fields.
• Once the required changes have been entered, click Save.

To add a new revision, click New. The Revision Entry window (described above) is then
displayed. Enter the required details and click Save.

To delete a revision, select the revision and click Delete. A message will then be displayed
requesting that the deletion be confirmed. Click Yes to confirm the deletion or No to cancel. 

5.10 Drawing Issues
To issue a drawing or drawings, select them in the Drawing List grid and click Issue on the
List Tools - Drawings tab.

If there are reasons why selected drawings cannot be issued, they are listed in the Error
Summary window.
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Click Cancel to stop the procedure. Click Continue to continue with the issue of any other
selected drawings. The first of the selected drawings for which errors were not detected is
then issued as described next. 

A Progress window for the issue is displayed:

If the drawing has already been issued at the current revision, or has had no revisions
created for it, a message window is displayed to inform that the user that a new revision
must be created before issuing. 
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Click Cancel to cancel the issue or OK to create a new revision. Refer to Drawing Revisions 
for further information on creating a new revision. Once the revision has been created, the 
issue procedure automatically resumes.

The issued drawing is then opened in AutoCAD (refer to Issues when Opening AutoCAD
Drawings), and the Update Options window is displayed. Refer to Create or Update
Drawings for details. Once the update is completed, the drawing is automatically closed.

If multiple drawings have been selected for issue, each is issued one at a time, as described
above.

5.10.1 Highlight Drawings for Reissue
To highlight issued drawings which show data that has been changed in the database, and
therefore require updating and reissuing, select the drawings to be checked from the
Drawing List and then click Highlight Documents for Reissue on the List Tools -
Drawings tab.

The drawings are then checked for changed data, and those that include changed data are
highlighted to the user by displaying an asterisk * in the Rev field after the revision number.

The highlighting drawings should then be updated (refer to Create or Update Drawings),
and issued again (refer to Drawing Issues).

5.10.2 View Previous Issues
To see previous issues click either Open Issues For Selected or Open Issues For All on
the List Tools - Drawings tab.
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The Issues window is then displayed.

If Open Issues For Selected was clicked the window lists all the issues for the drawing
currently selected in the grid. If Open Issues For All was clicked the window lists all the
issues for all the drawings in the grid.

Note: If the revision associated with an issue has been deleted, the Cancelled check box
for the issue will be checked. The issue itself however will not be deleted, and the
issued drawing may still be opened and viewed.

Command Buttons:

Open Opens the selected issues in AutoCAD (refer to Issues when Opening
AutoCAD Drawings).

Delete Deletes the selected issues. A confirmation message is displayed before
the deletion takes place.
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5.11 Non-AI Termination Drawing References
To view, add and edit list of non-AVEVA Instrumentation Termination Drawing numbers for
equipment, click External Ref Drawing Nos on the List Tools - Drawings tab. The
Termination Drawing References window is then displayed:

Note: Before an issue of a drawing can be deleted, all later issues of that drawing must
first be deleted. A message is displayed if a user attempts to delete an issue of a
drawing for which later issues exist. For example:

Print Prints the selected issues.

Find Displays the Find window, used to search by any text string located
anywhere within the grid.

Filter Opens the Advanced Grid Filters window used to define the current grid
view filter criteria.

Refresh Updates entire grid with latest database information (useful in multi-user
project environments).

Close Closes the window.
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To add a new drawing reference, click New. A new row is then added to the window. Enter
the equipment number and the drawing number in the fields provided.

To edit a drawing reference, type new values into the references fields as required.

To delete a drawing reference, click on it, then click Delete. A message is then displayed
requesting that the deletion be confirmed. Click Yes to proceed with the deletion.

Only one drawing reference can be deleted at a time.

To save changes made to the list of drawing references and to exit the window, click Save.

To exit the window without saving, click Cancel.

5.12 Drawing Publishing
Drawings in the Drawing List (and also the Hookup Drawing List) can be published, i.e. their
AutoCAD files saved to a pre-defined location. 

PDF versions of the published drawings may also be produced.

The folder that drawings are published to, whether or not PDF versions of the published files
are to be produced, and other options are specified using the Publishing Configuration
window. 

5.12.1 Publishing Configuration
Before drawings can be published, a number of configuration options must be specified.
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Select Drawings Publishing Configuration from the Setup menu on the Project tab. The
Export to External System Configuration window is then displayed:

In the Publishing folder field, enter the folder into which drawings are to be published, or
click … and browse for it.

If PDF versions of published files are to be generated using AutoCAD, in addition to the
published DWG files, check Publish as PDF.

If PDF versions of published files are to be generated using a PDF generator other than
AutoCAD, in the Executable to handle publishing field, enter the name and location of the
executable file that will handle the publishing, or click … and browse for it. If Publish as
PDF is checked, this setting will be ignored.

For each published drawing, an XML file containing selected drawing data is also produced
in the publishing folder. To select the drawing data that the XML file will include, click Add. A
blank row is added to the area below this button. From the drop down list in this row, select
the required drawing data. Repeat for each type of drawing data required.

To delete a row, select it and click Delete. A message will be displayed requesting that the
deletion be confirmed. Click Yes.

If no fields are selected, the XML files are not generated.

To save configuration changes and exit the window, click Save.

To exit the window without saving any changes, click Cancel.
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5.12.2 Publishing Drawings
To publish drawings, select them in the grid and click To External System on the List Tools
- Drawings tab. Multiple drawings can be selected and published.

The drawings will then be published to the publishing folder along with (optionally) the PDF
and XML data files. 

The Print Options window is then displayed.

Specify the required print options and click Print. The PDF files are then generated.

If PDF versions of the drawings are to be generated using another PDF generator, this is
used to generate the PDFs instead. 

Any errors that occur during the publishing process are reported in the Error Summary
window.
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Click Continue to carry on with the procedure or Cancel to stop it.
12 Series5:34© Copyright 2000 to current year.
AVEVA Solutions Limited and its subsidiaries. 
All rights reserved.



Instrument Designer User Guide
Drawing Generation
6 Drawing Generation

This section describes how Designer generates CAD drawings from the Drawing List.
However, before any CAD drawing can be created, a drawing record must exist in the
Drawing List for each drawing to be created as a CAD file. This topic assumes drawing
records already exist.

Note: To add a drawing record to the Drawing List use either the Add a New Drawing
procedure or import drawings from the Engineer's instrument list (loop diagrams) or
Wiring Manager's equipment list (termination diagrams) using the Import Drawings
into the Drawing List commands.

Updating CAD Text/Attributes

Designer uses DataLinks to establish a link between a value in the AVEVA Instrumentation
project database and a drawing block attribute, so that when a drawing is generated by
Designer the CAD attribute is automatically updated with the data from the database.
DataLinks can be linked to data such as project name or number or client name from Project
Data, or drawing number or title from the Drawing List, Loop No, Tag No, Cable No or other
engineering data from Engineer or Wiring Manager data. Once the DataLinks are added to a
drawing they ensure that the engineering data in drawings is the same as that currently in
the project database. Refer to the DataLinks for more information.

6.1 Loop Diagrams and Hookup Drawings
Template files are used as templates for both loop diagrams and hookup (installation)
drawings. Templates are copied to create the drawing file and are not modified graphically,
except for text values (AutoCAD attribute values) that have DataLinks assigned. When a
drawing based on a Template is updated, every DataLink is evaluated and translated into a
value based on the current drawing's data and is placed into its corresponding drawing
attribute. DataLinks are easily placed into templates file blocks: refer to Assign DataLinks in
AutoCAD.

If a loop diagram is to be created the Loop No field for the drawing must contain a valid
project loop number from the Engineer Loop List. If a hookup drawing is to be created the
drawing must be assigned to a hookup template via the Add a New Hookup Drawing
window.

Loop and Hookup Drawing Creation

There are two Drawing List commands that can create a Loop or Hookup CAD drawing:
Open and Update on the List Tools - Drawing tab.
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These commands are used as follows:
• Open - used to view the current drawing in CAD (refer to Issues when Opening

AutoCAD Drawings).
• Update - used to update the drawing with database information (Datalinks, if any), then

view the updated drawing in CAD.

When either of these commands is used, Designer performs the following actions:

If Drawing file Exists

Opens the drawing file in CAD.

If updating, then DataLinks are updated (design data is copied from the database)

If Drawing file does NOT Exist

If drawing has a Template then the Template file is copied to create the Drawing file.

Opens the drawing file in CAD. 

If updating, then DataLinks are updated (design data is copied from the database into the
drawing block attributes).

Important: The template is only copied if the drawing file does not exist. Therefore, any
changes made in a drawing once created from a template will remain in the
drawing and those changes will not be overwritten. This gives the flexibility to
start a drawing based on a template, then modify that drawing as required, in
affect making the drawing a template for itself.

6.2 Termination Diagrams
Seed Files are used as a base to start automated drawing activity and are used to create
termination drawings. Typically a Seed File contains the drawing title block, (and company
logos) revision blocks etc with attributes and DataLinks attached). When a drawing based
on a Seed File is updated, every DataLink is evaluated and any change is placed into its
associated drawing attribute (e.g. Title Block and revision data is updated in the drawing). 

If the drawing being updated is a Termination Diagram (actually, if it has an Equipment No
value), then the existing drawing file (if any) is deleted and created again by copying the
seed file, then terminations are parametrically (automatically) drawn based on the Wiring
Manager's termination data for that equipment number and the Seed drawing’s parameter
data.

Command Functionality Remarks

Open Opens drawing file, no data
is updated

Only applicable to one drawing at a time

Update Opens drawing file and
updates data via AVEVA
Instrumentation DataLinks

Can be used on any number of selected
drawings
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Seed File parameters include drawing sheet size (physical dimensions), the maximum
number of terminal strips per drawing, maximum number of terminals per terminal strip/Din
Rail, spacing between terminal strips etc. Refer to Seeds List for more information.

In addition to the Seed File parameters, which are defined per Seed File, AVEVA
Instrumentation provides user project definable preference settings that control drawing
parameters such as terminal height/width, cable core/wire length, text heights etc. These
project preferences are set in Designer's Auto Insert Blocks window.

To create a termination diagram, the Equipment No field must contain a valid project
equipment number from the Wiring Manager's Equipment List and there must be internal
terminals/devices with cable/wire connections.

Multiple Equipment Items and Drawing Sheets

If the selected equipment has more terminations than can fit on a single drawing sheet,
additional drawing sheets will be created automatically as required when the drawing is
created or updated during this procedure.

These additional sheets will be added to the Drawing List and assigned automatically
generated (incremented) sheet numbers and index sheet order numbers. 

If a termination diagram drawing number is associated with more than one item of
equipment, only the sheet or sheets for the item selected when the Update option was
clicked are created/updated. 

If an update results in the number of drawing sheets increasing or decreasing, the sheet
numbers and index sheet order numbers for all subsequent drawing sheets are
automatically increased or decreased as appropriate to reflect this. 

Only drawing sheet numbers in the same sequence as the updated drawing are affected.
So, if sheets of the Cover, Index, Notes and Reference Drawing Sheet Drawing Types are
identified using a separate sequence from the termination diagram drawing sheets with the
same drawing number (e.g. by using letters), these sheet numbers will not be changed.

Termination Drawing Creation

There are two Drawing List commands that can create a Termination CAD drawing: Open
and Update on the List Tools - Drawing tab.

These commands are used as follows:
• Open - used to view the current drawing in CAD (refer to Issues when Opening

AutoCAD Drawings).
• Update - used to recreate the drawing with database information (if any), then view the

updated drawing in CAD.

When update is used, the Seed file is copied to create the Drawing file (whether the drawing
file exists or not).

Command Functionality Remarks

Open Opens drawing file, no data is
updated

Only applicable to one drawing at a time

Update Recreates drawing file and
updates data via AVEVA
Instrumentation DataLinks

Can be used on any number of selected
drawings
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The drawing file is opened in CAD and the DataLinks are updated (design data is copied
from the database into the drawing block attributes).

Terminations are parametrically (automatically) drawn based on the equipment layout/
terminations designed in the project database.

6.3 Enhanced Cable Block Diagrams
Like Termination diagrams, enhanced block cable diagrams are based on seed files which
contain the drawing borders, title blocks etc. Seed File parameters include drawing sheet
size and extents. 

Enhanced block cable diagrams use a specific sub-set of seed files. Refer to Enhanced
Cable Block Diagram Seeds List for further information.

Distribution Drawing Creation

There are two Drawing List commands that can create a enhanced block cable diagram
CAD drawing: Open and Update on the List Tools - Drawing tab.

Think of these commands as:
• Open - used to view the current drawing in CAD (refer to Issues when Opening

AutoCAD Drawings).
• Update - Used to recreate the drawing with database information (if any), then view the

updated drawing in CAD.

When update is used, the Seed file is copied to create the Drawing file (whether the drawing
file exists or not).

6.4 Open a Template Drawing with AutoCAD
To open a template file in AutoCAD, start AutoCAD and then use the file open command
and navigate to the project template folder. Use the Project tab > Edit Project menu option
to view the template folder name (refer to Issues when Opening AutoCAD Drawings).

Alternatively, open them in AutoCAD from within Designer from the list of project templates,
as described below.

To open the list of templates, click Select in the Grids and Schedules section of the Home
tab. Select Templates from the list of grids that is then displayed. The Templates grid is then
displayed:

Command Functionality Remarks

Open Opens drawing file, no data is
updated

Only applicable to one drawing at a time

Update Recreates drawing file and
updates data via AVEVA
Instrumentation DataLinks

Can be used on any number of selected
drawings
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This window lists all the drawing files in the project template folder. Times Used shows the
number of drawings in the Drawing list that use each template.

Note: If templates have been created in a folder other than the project’s Template folder,
copy them to the project Template folder. They will appear in this list the next time the
Templates list is opened.
To find out what the project template folder is use the Project tab's Edit Project
option. This displays a window that contains all the project settings, including the
names of folders being used by the project.

To open a template in AutoCAD, select the template file name and click Open from the List
Tools - Templates tab. AutoCAD then starts (if not already running) and the file is opened.

Note: This grid to open can only be used to open templates drawings. To create a new
Template, users should copy the templates they create into the project's Template
folder or use AutoCAD's Save As command to save to that folder.

Templates Used Report

A report listing the templates used in the project and how often each of them has been used
can be accessed by selecting Templates Used from the Reports grid.

For descriptions of the toolbar buttons of the report window, refer to Reports.
12 Series6:5© Copyright 2000 to current year.
AVEVA Solutions Limited and its subsidiaries. 
All rights reserved.



Instrument Designer User Guide
Drawing Generation
6.5 Assign DataLinks in AutoCAD
To assign or modify DataLinks to an AutoCAD template or seed drawing file, the file first
needs to be opened using AutoCAD (refer to Issues when Opening AutoCAD Drawings).

Refer to Open a Template Drawing with AutoCAD for how to open a Template drawing file.

Refer to Seeds List for how to open a Seed drawing file.

Use of the Designer AutoCAD Menu

When assigning new DataLinks (or modify DataLinks already assigned) first ensure the
AVEVA Instrumentation AutoCAD menu is loaded into AutoCAD. This toolbar menu should
be automatically loaded when an AutoCAD drawing is opened from Designer.

Note: If the 'AVEVA Instrumentation' menu is not auto loaded the Designer.mns menu will
need to be loaded manually (using the AutoCAD 'menu' command). 
The menu files are located in the AVEVA Instrumentation program installation folder.

To Assign/Edit DataLinks

Once the AutoCAD AVEVA Instrumentation menu is loaded, select AVEVA
Instrumentation from the pull-down menus, then Edit DataLinks.

This displays a window showing all attributes in the selected AutoCAD block.

AutoCAD will prompt users to select objects. 

Select a block with attributes, and then press enter. AutoCAD will display the Edit
DataLinks window:

This window shows all attributes and datalinks defined in the block selected. 

Note: To view available Keyword DataLinks for any drawing in the Designer's Drawing List
open the DataLinks Window. This window includes 'copy and paste facilities' of
DataLinks from the report window into the AutoCAD DataLinks Edit window.

To assign a DataLink, either type in a valid DataLink or copy it from the DataLinks Window
(using Windows copy and paste - Ctrl-C / Ctrl-V etc) or by dragging and dropping from that
window (hold the Ctrl key and drag the report DataLink to a field above).

Refer to DataLinks for more information on DataLinks.
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Copying Blocks with DataLinks in AutoCAD

Since DataLinks are defined as Extended Entity Data within AutoCAD, their behaviour is
same as Xdata. That is, if a block is copied with DataLinks attached, the DataLinks are
copied too. This can drastically reduce data entry when setting up DataLinks.

For example, required DataLinks can be attached to a block that may represent a Field
Device. That block can the be copied to as many drawings as required, saving the effort of
re-entering the DataLinks each time. Another example is the Title block used in all drawings.
Set-up the first drawing with all DataLinks, and once it has been tested, copy that Title Block
(which may contain multiple AutoCAD blocks) to the other drawings.

Auto-Erasing Blocks with DataLinks in AutoCAD

Designer provides an 'Auto-Erase' (or auto-delete) function where a block will be
automatically erased from a drawing if a specific DataLink returns nothing. If a DataLink
attribute is prefixed with <DEL> and AVEVA Instrumentation detects that the following
DataLink has no value, then Designer will erase the block containing the <DEL> Datalink.

For example, it is required to erase a block if there is no tag number for {TAG10}. Entering:
<DEL>{TAG10} in for an attribute in a block will tell AVEVA Instrumentation to erase the
block if {TAG10} evaluates to nothing (i.e. there is no TAG10 for this drawing).

6.6 DataLinks Window
To view DataLinks for any drawing in a project:

• Select a drawing from the Drawing List, then click Show Datalinks on the List Tools -
Drawing tab

• Or right-click on a drawing in the Drawing List and click Show Datalinks on the menu
that is then displayed.

The DataLinks window is then opened which shows all DataLinks generated for the
selected drawing. DataLinks are grouped into logical groups.

Note: DataLinks are created based on the current drawing type (i.e Loop, Termination or
Hook-up Diagram) and the current engineering data assigned to the AVEVA
Instrumentation object type (i.e Loop, Equipment or Hookup Type). A complete set of
DataLinks is not available to each drawing until the engineering data is complete (i.e.
the loop wiring, equipment terminations or hookup template is finished). 
The project-specific properties that may be setup in the Engineer and Process
Engineer modules are available as DataLinks.

To view DataLinks for a group select the '+' box at the left of the group name:
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The example above shows DataLinks for the Drawing List Data group. If the DataLink
{DWGNO} is placed in the AutoCAD drawing file then it will be updated during auto
generation with the value “00-75002”. For more technical information about DataLinks refer
to DataLinks. The DataLinks are grouped by Type (e.g. Project Data, Drawing List, Loop
List, Instrument List, DCS I/O, Wiring etc). This grid can be printed for reference or users
can copy and paste into AutoCAD Templates etc via Designer.

DataLinks can be copied from this DataLinks window directly into the AutoCAD symbols
(blocks) used as templates for loop diagrams and/or title blocks used as Seeds. To copy a
DataLink select it (click on the DataLink) and use the Ctrl + C keys to copy to the Windows
clipboard. Then select the AutoCAD DataLink field and paste the DataLink value. Refer to
Assign DataLinks in AutoCAD.
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DataLinks can also be copied by 'drag and drop' selecting one (click in the white space
immediately to the left of the DataLink field) and dragging the DataLink into an AutoCAD
DataLink field and dropping it (release the mouse button).

When copied to an AutoCAD attribute, the DataLink is stored within the Block inside
AutoCAD. Blocks (including DataLinks) may be copied within an AutoCAD drawing file or
between drawing files using standard AutoCAD commands (copy, insert etc), any DataLinks
will remain within the copied blocks and drawings. This means DataLinks can be setup for
typical blocks which can then be copied to create new templates without having to assign
Datalinks to those blocks again.

Refer to Assign DataLinks in AutoCAD.

The following table shows typical DataLinks shown for each group:

Group Name 
Project Data:

DataLink Example Value

 {ProjectNo} 25400

 {ProjectName} FuelX Modernisation

 {ProjectDesc} Refinery Clean Fuels

 {PlantName} FuelX

Drawing Data:   

 {DwgNo} 340-07-1045

 {Sheet} 1

 {NoOfSheets} 1

 {Title1} Area 340

Drawing Revisions:   

 {RevNo1} A

 {Date1} 7/7/2003

 {Revision1} ISSUED FOR REVIEW

 {By1} GRH

Instrument Tag Data:   

 {TAG1} 34-FT-1005

 {TAG1Manufact} Honeywell

 {TAG1Model}

Tag Wiring Data:   

 {TAG1T1} +

 {TAG1W1C1CableNo} C34FT1005

 {TAG1W1C1CableType} 1Pr
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DataLinks for Project Data, Drawing Data and Drawing Revisions are always the same
regardless of drawing type being generated (whether the drawing is based on a Template or
Seed or whether it is a Loop Diagram, Termination Diagram, Hookup or any other type).
However, the Revision DataLinks always end in a number corresponding to Revision history
sequence (example: {RevNo1} is always earliest Revision, {RevNo2} is the second earliest
etc).

DataLinks for Instrument Tag Data always end in a number corresponding to the 'Loop Dwg
Code' set for each instrument in the Instrument List. This number must be unique for each
instrument in a loop and is used to identify each instrument in the loop drawing. This 'Loop
Dwg Code' can be modified from Instrument Engineer or Designer from the View and Edit
Drawing Information window or the 'LoopDwgCode' field can be added to a GridView in
Engineer's Instrument List for bulk editing.

Note: Setting 'Loop Dwg Code' by instrument type should be considered. For example
Transmitters = 11, Solenoid Valves = 51, Control Valves = 61 etc. This may reduce
editing associated with each DataLink in the AutoCAD templates. A set of blocks
may easily be setup to represent a Transmitter and all its associated wiring, junction
boxes, marshalling cabinet all using DataLinks like {TAG11. Once this is done, this
set of symbols may be copied to make up more complex loops containing transmitter,
I/P, Limit switches etc.

6.7 Seeds List
Seed drawings are used by Designer to create termination drawings. Seed drawings are
normally just an empty drawing file containing a drawing title block (drawing frame with
attributes). The title block will have attributes linked to the project database using DataLinks.
In addition to the title block, AVEVA Instrumentation requires specific parameters to enable
termination diagrams to be automatically drawn. These parameters are set in the Seed File
Parameters window.

Note: To use a Seed file to auto-generate drawings, all the Seed parameters below must
be entered for the Seed file and the Seed file must be located in the AVEVA
Instrumentation project 'Seed' folder.

To open the Seed Drawing List window which lists of all Seed files for the project, click
Select in the Grids and Schedules section of the Home tab.

Select Seeds from the list of grids that is then displayed. The Seeds grid is then displayed:

This window contains a list of all Seed drawing files added to the project database through
this window.

 {TAG1W1C1Core} WH

 {TAG1W1E1} 34-JB-114
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Note: Ensure that a Seed file is copied (or saved in AutoCAD) to the project seed folder
with the same file name as the 'Seed File' name entered in the Seed List, otherwise
Designer cannot use the seed drawing to generate termination drawings.

This Seed Drawing List contains important information used by Designer when termination
drawings are parametrically created. The following parameters are required to be entered
for all Seed drawings:

Notes:

1. If the Equipment being drawn has multiple terminal strips or the number of terminals in
a single terminal strip exceeds the MaxNoOfTerminals parameter, then Designer will
start a new strip of terminals. If the MaxNoOfTStrips is exceeded for the current
equipment, then AVEVA Instrumentation will automatically create a new drawing sheet
and continue to draw terminals/terminal strips until there are no more terminals/
terminal strips for the Equipment. AVEVA Instrumentation will continue to create new
sheets if required.

2. If the Equipment being drawn has terminal strips containing more terminals in a single
terminal than the MaxNoOfTerminals parameter then Designer will start a new
Terminal Strip to continue until all terminals are drawn. If the MaxNoOfTStrips in not
exceeded, the continuation Terminal Strip is drawn on the same drawing sheet. If the
MaxNoOfTStrips is exceeded for the current equipment, then AVEVA Instrumentation
will automatically create a new drawing sheet and continue to draw terminals/terminal
strips until their are no more terminals.

3. ExtentsMinY controls the positioning of cables drawn to the bottom of the drawing.
AVEVA Instrumentation will not draw below the ExtentsMinY.

Parameter Description

Seed File A unique name that matches the Seed File name (the AutoCAD
drawing file name).

Description User defined description (optional).

Size User defined size - used to help a user select the appropriate
seed drawing size (optional).

TStrip Start X X coordinate where the first terminal strip will be started (the top
left of the strip).

TStrip Start Y Y coordinate where the first terminal strip will be started (the top
left of the strip).

TStrip Spacing Horizontal spacing ('X') between terminal strips.

Max No. of 
Terminals

Maximum number of Terminals to draw in a single vertical set of
terminals before start at top again.

Max No. of TStrips Maximum number of Terminal Strips to be placed on the drawing
(see Note 1 below).

Extents Min/Max X/
Y

Minimum and maximum X and Y coordinates in which AutoCAD
can draw within the title block (ExtentsMinY affects bottom of
vertically drawn cables).

AllCablesVertical Defines whether all cables will be drawn to the bottom of the
drawing sheet (to the ExtentsMinY above) - see the Exceptions
setting below.
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4. The coordinates at which an intermediate Junction Box terminal strip (if present) will be
located (its top left corner) are specified by the following formula:

TStrip Start X - (Cable Length + (2 x Core Length) + Terminal Strip Width)

TStrip Start X is set in the seed file parameters (see below).
Cable Length, Core Length and Terminal Strip Width are set on the Terminations
Tab of the Options window.

To Open a Seed in AutoCAD

Select the Seed file name, click Open on the List Tools - Seeds tab. AutoCAD then starts
(if not already running) and the file is opened (refer to Issues when Opening AutoCAD
Drawings).

Note: In order for dashed lines to be displayed correctly in drawings that use a seed file:

• The LWDISPLAY command must be set to ON.
• The LTSCALE may need to be adjusted.

To Add a New Seed File

To add a new Seed file, click New on the Home tab (existing seed records can be copied by
using the Copy command, accessed by click the arrow next to the New option).

AVEVA Instrumentation then displays the Seed File Parameters window (the following
example shows the window after typical parameters have been entered for a metric
drawing):

Complete all parameters as described, in the drawing units required in the AutoCAD
drawing files (i.e. mm or inches)

Parameter Description   

Seed File Name A unique name that matches the Seed File name (the AutoCAD
drawing file name).

Description User defined description (optional).
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Note: Remember that to use a new Seed file an AutoCAD drawing file with the same name
as the seed entry must exist in the AVEVA Instrumentation project 'Seed Folder'.

6.8 Enhanced Cable Block Diagram Seeds List
Seed drawings are used by Designer to create enhanced cable block diagram drawings.
Seed drawings are normally just an empty drawing file containing a drawing title block
(drawing frame with attributes). The title block will have attributes linked to the project
database using DataLinks. In addition to the title block, AVEVA Instrumentation requires
specific parameters to enable distribution diagrams to be auto-drawn. These parameters are
set in the CBD Seeds File Parameters window.

Note: To use a CBD Seed file to auto-generate drawings all the Seed parameters below
must be entered for the Seed file and the Seed file must be located in the AVEVA
Instrumentation project 'Seed' folder.

Note: A different type of Seed file is used to generate Termination drawings. Refer to
Seeds List.

To open the CBD Seeds list window which contains a list of all CBD Seed files for the
project, click Select in the Grids and Schedules section of the Home tab.

Select CBD Seeds from the list of grids that is then displayed. The CBD Seeds grid is then
displayed:

Size User defined size - used to help a user select the appropriate seed
drawing size (optional).

TStrip Start X X coordinate where the first terminal strip will be started (the top left
of the strip).

TStrip Start Y Y coordinate where the first terminal strip will be started (the top left
of the strip).

TStrip Spacing Horizontal spacing ('X') between terminal strips.

Max No. of 
Terminals

Maximum number of Terminals to draw in a single vertical set of
terminals before start at top again.

Max No. of 
TStrips

Maximum number of Terminal Strips to be placed on the drawing
(see Note 1 above).

Extents Min/
Max X/Y

Minimum and maximum X and Y coordinates in which AutoCAD can
draw within the title block (ExtentsMinY affects bottom of vertically
drawn cables).

Draw All Cables 
Vertically

Defines whether all cables will be drawn to the bottom of the drawing
sheet (to the Extents Min Y above).

Exceptions If Draw All Cables Vertically is selected then the user may add a list
of exceptions. Exceptions are cable types that will always be drawn
horizontally and are entered with a comma delimiter. In the above
example all cables will be drawn vertically except cables that are 1Pr,
2Pr, 4Pr, 1Tr, 2Tr, 1C, 2C etc as shown the Exceptions field.
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Note: Refer to Working with the Data Grid for information on the grid control including how
to select a record.

This window contains a list of all Enhanced CBD Seed drawing files added to the project
database through this window.

Note: Ensure that a Seed file is copied (or saved in AutoCAD) to the project seed folder
with the same file name as the 'Seed File' name entered in the Seed List otherwise
Designer cannot use the seed drawing to generate distribution drawings.

To Open a CBD Seed in AutoCAD

Select the CBD Seed file name, click Open on the List Tools - Seeds tab. AutoCAD then
starts (if not already running) and the file is opened. 

To Add a New CBD Seed File

To add a new CBD Seed file, click New on the Home tab (existing seed records can be
copied by using the 'copy' drop down toolbar command next to the New option).

The CBD Seed File Parameters window is then displayed:

Complete all parameters as described in the drawing units required in the AutoCAD drawing
files (i.e. mm or inches):

Parameter Description

Seed File Name The AutoCAD drawing file. Click the ... button to open a file browser
to be used in selecting the required file.
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Note: Remember that to use a new Seed file, an AutoCAD drawing file with the same name
as the seed entry must exist in the AVEVA Instrumentation project 'Seed Folder'.

6.9 Auto Insert Blocks
Designer enables the auto-insertion of user-defined blocks into any AVEVA Instrumentation
generated drawing by adding block names to the Drawing List for any or all drawings. The
inserted blocks can contain DataLinks that will be updated by AVEVA Instrumentation with
project data. AVEVA Instrumentation supports up to 6 blocks per drawing. Blocks are always
inserted at drawing coordinates 0,0.

This feature was added to AVEVA Instrumentation to enable users to reduce the number of
seed and template drawings as often the only difference between drawings is a different set
of drawing notes etc. 

It can also be used in a situation where it is required to show detailed process data, such as
a detailed 'P&ID' type bubble diagram on Loop Diagrams. In this case, although the wiring is
standardised and a simple template could be used on, for example 50 loops (e.g. 2 Wire
Analog Input to DCS), the process connections may be quite different. The Auto Inserting
Blocks facility can be used here as only one template (wiring) is required, but maybe 3 or 4
different 'P&ID' Blocks can be used depending on whether the transmitter is a D/P Flow
connected to a orifice plate, a D/P Level transmitter connected to a vessel etc.

Add an Auto-Inserting Block

To enable Designer to locate the user-defined blocks, each block must reside in the current
projects 'CAD Block/Circuit' folder as defined in the Project Setup window (Project tab >
Edit Project option).

To assign blocks to a specific AVEVA Instrumentation Drawing add the block name to one of
the Drawing List's six block fields (Block1, Block2, etc.). The easiest way to do this is to add
the Block fields to a GridView using the AVEVA Instrumentation Grid Manager, accessed
from the Manage option on the Home tab (refer to the Common Functionality User Guide
for details).

Once the Block fields are in the Drawing List data grid, select the required value from the
pull down list that appears in each 'Block' cell of the grid when the mouse is hovered over
that cell.

When generating the drawing AVEVA Instrumentation inserts any defined Blocks just prior
to updating DataLink data so DataLinks can be embedded in the Auto Inserting Blocks
successfully.

Seed Type The type of drawing that the Seed file is for, in this case always
Enhanced Cable Block Diagrams.

Description User defined description (optional).

Extents Min X 
and Y 

Minimum coordinates from which AutoCAD can draw the seed
drawing border, i.e. its starting point.

Extents Max X 
and Y 

Maximum coordinates to which AutoCAD can draw the seed drawing
border.

Scale to Fit Check this checkbox if the diagram contents (as defined in Wiring
Manager) are to be scaled to fit within the extents of the seed
drawing border.
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Note: AVEVA Instrumentation only inserts these Blocks if the drawing is being created (i.e.
the drawing file does not currently exist). To add Blocks to an existing drawing, delete
the drawing file prior to Update for the blocks to be auto-inserted.

6.10 DataLinks
Designer enables any attribute within any AutoCAD drawing to be updated from the AVEVA
Instrumentation Project Database. A DataLink is attached to each block's attributes in a
Template file or Seed file as Extended Entity Data (Xdata). Extended Entity data is invisible
in AutoCAD, so the DataLinks will not effect the CAD file visually.

Note: DataLink definitions are invisible within the drawing file and can only be accessed by
an applications program such as Designer (or AutoLisp/Visual Basic etc).

An AVEVA Instrumentation DataLink represents a data value that is replaced by the actual
project data when updated by Designer. When a drawing is updated by Designer, all
AutoCAD attributes that contain a DataLink are automatically updated with the current data
from the AVEVA Instrumentation project database. This data could include title block and
revision information as well as engineering, wiring or other project data.

Types of DataLinks

Designer uses two types of DataLinks:
• Keywords. These are always enclosed in curly brackets {}

Examples:

Note: Refer to DataLink Keyword Samples for a comprehensive list of Keyword DataLink
definitions used within Designer.

• SQL Statements. These are always enclosed in curved brackets ( ) and are written in
the form of a standard SQL (Structured Query Language) query definition for database
access:

(SELECT Field1 FROM TableName WHERE Field2 = Value)

For example:

(SELECT ModelNo FROM InstrumentList where TagNo ='FT-600')

...returns the ModelNo field value from the InstrumentList table where the TagNo field is
equal to FT-600).

Keyword DataLinks are predefined within the Designer and cannot be user defined.

SQL Statements are user-definable and are included to enable advanced users to access
data that has not been defined as a Keyword DataLink.

Note: To view available Keyword DataLinks for any drawing in the Designer's Drawing List
bring up the DataLinks Window.

{DwgNo} returns the value of the Drawing Number field for the current drawing.

{Title1} returns the value of the Title1 field of the Drawing List for the current
drawing.

{Tag1} returns the Tag No of the first instrument in current loop (if the current
drawing is a Loop Diagram).
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Multiple DataLinks

Designer supports multiple DataLinks for each Block Attribute. They can be used to update
multiple values within a single attribute.

For example:

Attribute with DataLinks: {DWGNo} {Rev1} would fetch the current drawings
'Drawing No' and 'Rev1' fields and append them together with a space in between
(such as D1234 A - if 'Drawing No was: 'D1234' and Revision 1 was 'A').

Character or numerical values may also be concatenated within the DataLink definition.

For example:

Attribute with DataLinks: Dwg No.{DWGNo}-{Rev1} would return the current
drawings Drawing No field and append it after the characters 'Dwg No. ' followed by a
'-' (dash) followed by the current drawings value of the Rev1 field.

Nested DataLinks

Designer supports Nested DataLinks for each Block Attribute. They can be used to update
multiple values within a single attribute or used as a lookup value in a SQL type DataLink.

For example:

Attribute with DataLink: (SELECT DrawnBy FROM Drawings WHERE DwgID =
{DwgID})

Here the Keyword DataLink {DwgID} is being used as the value to search for in the DwgID
field of the Drawings table.

Another example: how to get access to any data from the InstrumentList:

In the following DataLink the Keyword DataLink {TAG1Key} is unique name of
instrument 1 in the loop currently being created/updated. We use that value to lookup
a field in the AVEVA Instrumentation InstrumentList table. Here we are returning the
value of 'UserField1'.

(SELECT UserField1 FROM InstrumentList WHERE InstKey=
{TAG1Key})

Attaching DataLinks to Attributes in AutoCAD

Open the Template, Seed or Drawing File using Designer's Open options (on the List Tools
tabs) as this ensures the AutoCAD VBA (Visual Basic for Applications) program is loaded
into AutoCAD. If the 'AVEVA Instrumentation' tools menu is not visible the menu has not yet
been changed, so select the appropriate AutoCAD menu from wherever AVEVA
Instrumentation was installed. Refer to the Assign DataLinks in AutoCAD for more
information.

Editing DataLinks in AutoCAD

Refer to the Assign DataLinks in AutoCAD for more information.

Auto-Erase Block in AutoCAD using DataLinks

Designer provides an 'Auto-Erase' (or auto-delete) function where a block will be
automatically erased from a drawing if a specific DataLink returns nothing. If a DataLink
attribute is prefixed with <DEL> and AVEVA Instrumentation evaluates the following
DataLink with nothing (no value) then Designer will erase the block containing the <DEL>
Datalink.
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For example, it is required to erase a block if there is no tag number for {TAG10}. Entering:
<DEL>{TAG10} in for an attribute in a block will tell AVEVA Instrumentation to erase the
block if {TAG10} evaluates to nothing (i.e. there is no TAG10 for this drawing).

Forcing Uppercase Text in AutoCAD

Designer provides a method to change any DataLink values retrieved from the AVEVA
Instrumentation Database to uppercase. For example, the database value for {Client} may
be 'Xyz Oil Company’. To force this to become 'XYZ OIL COMPANY' prefix the DataLink
attribute with <UCASE> and AVEVA Instrumentation will update to uppercase. If both the
<DEL> operator (see above) and the <UCASE> operator are required, then <DEL> must be
the first within the attribute (e.g. <DEL><UCASE>{TAG1Manufaturer}).

Copying Blocks with DataLinks in AutoCAD

Since DataLinks are defined as Extended Entity Data within AutoCAD, their behaviour is
same as Xdata. That is, if a block is copied with DataLinks attached, the DataLinks are
copied too. This can drastically reduce data entry when setting up DataLinks.

For example, required DataLinks can be attached to a block that may represent a Field
Device. That block can the be copied to as many drawings as required, saving the effort of
re-entering the DataLinks each time. Another example is the Title block used in all drawings.
Set-up the first drawing with all DataLinks, and once it has been tested, copy that Title Block
(which may contain multiple AutoCAD blocks) to the other drawings.

Summary
• DataLinks are used to define where data comes from in the database and are attached

to Attributes as Extended Entity Data.
• There are two types of DataLinks: Keywords (predefined) and SQL statements

(which are user definable)
• DataLinks can be used to fill in values to a single attribute and they may be nested

within each other and/or concatenated within character strings
• DataLinks are attached and edited from within AutoCAD by selecting the desired block

containing attributes with the menu AVEVA Instrumentation > Edit DataLinks
command.

• Blocks may be copied with DataLinks within AutoCAD to reduce setup time (and to
copy entire drawings)

• A list of predefined keywords within the Designer Drawing List for any selected drawing
can be viewed by using the Show Datalinks option on the List Tools - Drawings tab
(after selecting a drawing in the Drawing List), which opens the DataLinks Window.
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7 Hookups

Hookup drawings are created by assigning a pre-defined Hookup Template to each project
hookup drawing. A Hookup Template is made up of two parts: 

• an AutoCAD drawing that contains the graphical representation of the installation
detail.

• a Bill of Materials or Parts List that is assigned from the Designer Hookup parts
catalogue.

Hookup drawings can be one of the following types: General, Process, Pneumatic or
Mounting.

When the project Hookup drawing is created, AVEVA Instrumentation updates the Hookup
Template drawing with all parts and all tags assigned to the drawing.

Continue at:
• Hookup Drawing List
• Add a New Hookup Drawing
• Assign a Hookup Template
• Assign Tags to a Hookup
• View and Edit Hookup Drawing Information
• Hookups Template Catalogue
• Hookup Items Catalogue
• Hookup Reports

7.1 Hookup Drawing List
The Hookup Drawing List is the main Designer module window for adding/editing and
accessing Hookup drawings.

To open the Hookup Drawing List, click Select in the Grids and Schedules section of the
Home tab.

Select Hookup Drawings from the list of grids that is then displayed. The Hookup Drawing
List grid is then opened:
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Note: Refer to Working with the Data Grid for information on the grid controls, including
how to select a record (a Drawing).

The grid provides details on each project Hookup drawing, including Drawing Number,
Hookup Type, Title, Current Revision etc.

The grid is very similar to the Designer Drawing List, except that it is filtered to show only
Hookup Drawings.

Mandatory Data

To produce a drawing, a drawing number and sheet number must be entered. Designer
uses these to create a file name. For example: Drawing No: 123456 and Sheet No: 1 are
combined to create a file name: 123456-1.dwg.

To produce project Hookup Drawings a pre-defined Hookup Template must be assigned to
each of the drawings in this Hookup Drawing List.

Auto Generation of Drawings

AVEVA Instrumentation uses 'DataLinks' to map database data to AutoCAD drawing
attributes. DataLinks are automatically updated by Designer when a drawing is opened or
updated from the Drawing List. For information on using Designer's DataLinks to update:
Drawing Title Block (Drawing Border) - including revisions history, Tags numbers assigned
to the hookup and the Bill of Materials (or Parts List) refer to Drawing Generation.

Hookup Drawing List - List Tools Options

The following options are located on the List Tools - Drawings tab.

These facilities are the same as those for the Drawing List, except where noted.

Records Section

Refresh

These common options are also located on the Home tab.
Refer to the Common Functionality User Guide for details.

New

Edit

Delete

Actions Tab

Open Opens the selected drawing for reviewing/printing etc in AutoCAD
(editing title block and revision information should be done from the Edit
button on the Home tab) (refer to Issues when Opening AutoCAD
Drawings).

Update Updates selected drawing(s) - DataLinks in each CAD drawing are
updated with current project data from the AVEVA Instrumentation
database. Refer to Create or Update Drawings for details.

Note: If the drawing file does not exist, the file is created by copying a) the template file
(if drawing uses a template drawing) or b) the seed file (if drawing uses a seed
drawing). Refer to the Drawing Generation for more information.

Issue Issues and updates selected drawing(s). Refer to Drawing Issues. 
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Open Issues 
For Selected

Displays the Issues window listing all the current issues for the selected
drawing. Refer to View Previous Issues for further information.

Open Issues 
For All

Displays the Issues window. Refer to View Previous Issues for further
information.

Revisions Displays a list of all drawings with revisions (and their revisions). Refer
to Viewing and Editing Multiple Document Revisions. 

Add 
Revisions

Used to create a new revision. Refer to Create a Revision.

Edit 
Revisions

Used to edit the current revision. Refer to Edit a Revision.

Check for 
New Loops

Checks for new Loop drawings created in the Engineer module and
imports them into the Drawing List. 
Not relevant to the Hookup Drawing List.

Check for 
New 
Terminations

Checks for new Termination drawings created in the Wiring Manager
module and imports them into the Drawing List. 
Not relevant to the Hookup Drawing List.

External Ref 
Drawing Nos.

Used to view, add and edit list of non-AVEVA Instrumentation
Termination Drawing numbers for equipment. Refer to Non-AI
Termination Drawing References.

Highlight 
Documents 
for Reissue

Used to highlight which issued drawings include data that has been
changed in the database and therefore should be updated and
reissued. Refer to Highlight Drawings for Reissue.

Tools Tab

Show 
Datalinks

Used to view the list of DataLinks for a selected drawing. Refer to
DataLinks Window.

Rename Used to rename batches of selected drawings. Refer to Rename
Selected Drawings.

Printing Tab

Print Prints selected drawing(s) - if the drawing files exists.

Export Tab

To External 
System

Publishes selected drawings to a folder. Refer to Drawing Publishing.

Selected 
Drawings Used to export selected drawings files in the following ways:

Copy/Archive 
to Folder

Used to export drawing files to a folder defined during
the export process. Refer to Export Drawings to a
Specified Folder.

Copy to User 
Defined 
Names

Used to export drawing files to a pre-defined folder or
folders with file names in a pre-defined, user-defined
format. Refer to Export Drawings to Pre-Defined
Folders with File Names in a Pre-Defined Format.
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7.2 Add a New Hookup Drawing
With the Hookup Drawing List open, click New on the Home tab to display the Hookup
Drawing Information window:

This window is identical to the standard Drawing Information window (see Add a New
Drawing) except that it has two additional tabs:

7.3 Assign a Hookup Template
In the Hookup Drawing Information window click Assign Type on the Template tab.

Template Used to select the Hookup Template to be used when
creating the Hookup Drawing. See Assign a Hookup
Template.

Tags Used to assign tags to the current Hookup Drawing. See
Assign Tags to a Hookup.
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This displays the Assign Hookup Template to Drawing window, listing the current Hookup
Drawing Catalogue template drawings:

To assign a template either double-click on the Hookup Template record, or click on the
Hookup Template record and then click Assign.

To add new template drawings to the project refer to Hookup Items Catalogue.

7.4 Assign Tags to a Hookup
To assign an instrument tag to a specific Hookup Drawing, in the Hookup Drawing
Information window double-click on an empty tag number record on the Tags tab.
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The Assign Tag Numbers window is then displayed:

By default, this list shows all tags not yet assigned to a Hookup Drawing. Check Show Tags
Already Assigned if all tags are to be listed.

To assign a tag to the current Hookup Drawing, double-click on its tag number.

Repeat the double-click selection as required to assign more than one tag (if the current
drawing has multiple tags that are yet to be assigned). 

Click Exit when the required tags have been assigned.

Alternatively check the Select checkboxes for the tags to be assigned, then click Assign to
assign all selected tags to the hookup drawing.

Note: The selected tag(s) are allocated to the next available spare tag position on the
hookup. If required, tags can subsequently be dragged into different positions. They
can also be deleted and “packed”. See View and Edit Hookup Drawing Information.
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7.5 View and Edit Hookup Drawing Information
To view and edit existing Hookup Drawing information, select the drawing in the Hookup
Drawing List and click Edit on the Home tab, or double-click on the drawing record in the
Hookup Drawing List. The Hookup Drawing Information window is then displayed.

Note: The Last Edit field displays the date and time when the hookup drawing data was
last edited. The user name of the individual that performed the edit is displayed in a
tool-tip when the mouse cursor is hovered over the field. Click the button in the field
to display the Audit Manager, which will display a list of all the changes to the hookup
drawing data. 

This window is identical to the normal Drawing Information window (see Add a New
Drawing) except it has two additional tabs:

Template Used to select the Hookup Template to be used when
creating the Hookup Drawing. See Assign a Hookup
Template

Tags Used to assign tags to the current Hookup Drawing. See
Assign Tags to a Hookup.
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Reassign a Tag Position in a Hookup Drawing

Select a tag and drag it into a new position.

The example below shows four tags. 

Drag the second tag and "drop" it onto the first position to move the selected tag to that
position. 

This will automatically move all tag data on the corresponding hookup drawing to the new
positions next time the drawing is updated.

Remove a Tag from a Hookup Drawing

Select a tag and click Un-Assign.

Note: Removing a tag does not delete its data. It only unassigns the tag from the drawing.

Pack Tags

If tags are removed and gaps appear in the list of assigned tags, the tags can be “packed”
using the Pack Tags button. This removes the gaps: tags are moved up the list to remove
them. Packing tags also re-sorts the order based on the tag number.

7.6 Hookups Template Catalogue
The Hookup template catalogue contains definitions of all the template drawings that can be
used to create project hookup drawings. A Hookup template drawing contains the graphic
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representation of the installation/hookup. It also includes place-holders so that the
component items/parts list can be created, and the instrument tags assigned to each
drawing listed. 

The place-holders are AutoCAD blocks with attributes. AVEVA Instrumentation uses
Datalinks to map each attribute to a database field so that when a template is used to
generate a project CAD drawing, all the component items and all tags are automatically
updated by AVEVA Instrumentation.

To open the Hookup template catalogue, click Select in the Grids and Schedules section
of the Home tab.

Select Hookup from the list of grids that is then displayed. The Hookup Catalogue grid is
then displayed:

7.6.1 Add a New Hookup Template
With the Hookup catalogue template grid open, click New on the Home tab to display the
Hookup Template Details window:

Enter a category, description, template name and the maximum number of tags that can be
assigned to Hookup drawings that use this template.
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Open the Template in AutoCAD / Select an existing AutoCAD drawing to be used as 
the Hookup Template

Click Open Drawing.

If a drawing with the same name as that entered in the Template field is found in the
Hookup templates folder for the project, this drawing is automatically selected and opened
in AutoCAD.

If there is no such drawing in that folder, a message is displayed asking whether or not the
required file is to be browsed for and copied to the Hookup templates folder:

Click Yes to proceed. A window is then displayed which is used to browse for the required
file. Once the required file is selected, click Open to open the drawing in AutoCAD and copy
it to the Hookup template folder.

Once the drawing is opened in AutoCAD appropriate DataLinks must be assigned to each
block attribute so AVEVA Instrumentation can update the attribute values with hookup item
bill of materials, tags assigned and title block information. Refer to Assign Hookup
DataLinks in AutoCAD.

Apply the appropriate DataLinks to each of the template drawings attributes to map fields to
update:

• Title Block information
• Drawing Revision history
• Tags Assigned
• Bill of Materials

Note: Once the AVEVA Instrumentation DataLinks have been assigned to the Template
drawing, Open Drawing will automatically update the DataLinks with the current Bill
of Materials saved to the database.

Assign a new Bill of Materials Catalogue Item to the Hookup Template

Click New Item to display the Find a Component window, used to assign items to the
template. Refer to Assign Hookup Items to Templates.

To change the quantity of any items assigned, click in the Qty grid column and edit the
value.

Remove an Item from the Bill of Materials

Select the item record and click Remove Item.
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7.6.2 View and Edit Template Data
To view and edit existing Hookup template information, select the template in the Hookup
catalogue template grid and click Edit on the Home tab, or double-click on the template
record in the Hookup catalogue template grid. The Hookup Template Details window is
then displayed:

Refer to Add a New Hookup Template for details.

7.6.3 Import Hookup Catalogue
The user may import Hookup catalogues from other AVEVA Instrumentation projects.

With the Hookup catalogue template grid open, select From Other Project from the Import
section of the Manage tab to display the Select an AVEVA Instrumentation Project
window. 

Select a project from the list of projects and click Select. The Hookup Catalogue Import
window is then displayed:
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Note: To minimise the possibility that data currently being worked on by another user may
be affected by an import, a list of the users working on the current project is available
from the UserCount link. The number of current users is displayed next to the link.
This total includes the user performing the import. 

The user can select individual templates to be imported by clicking the Select checkboxes
of the required templates. To select all the templates, click Select All to check all the Select
checkboxes. 

Clicking Cancel closes the Hookup Catalogue Import window.

After selecting the required templates, click Import to proceed with the import. A progress
window is then displayed.

The import process checks to see if the selected templates already exist in the project. If
any existing templates are found a message is displayed. For example:
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Click Yes to overwrite the existing template. The message will re-appear each time the
import process finds an existing template.

Click No to prevent the import process overwriting the existing template. The message will
re-appear each time the import process finds an existing template.

Click Yes To All to overwrite all the existing templates. The message will not re-appear each
time the import process finds an existing template.

Click No To All to prevent the import process overwriting the existing templates. The
message will not re-appear each time the import process finds an existing template

If during the import process files are found that do not have a Template Filename, a
message is displayed informing the user that these files will be ignored and not imported.

Click Yes to continue and Cancel to stop the import.

Files with a Template Filename will be imported, but if the import process cannot find the
template files themselves, a message is displayed informing the user that the template files
are not found.

Click OK to continue. The message will re-appear each time the import process cannot find
a template file.

After the import process is complete the Import Log window is displayed.
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The window shows the user the import status and displays the successfully imported files in
the grid view.

7.6.4 Assign Hookup Items to Templates
In order for components/items to be assigned to a Hookup Drawing, the items must be
assigned to the template that the drawing uses.

To assign items to a Hookup template, in the Hookup Template Details window (see View
and Edit Template Data), click New Item.

This displays the Find a Component window:
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Note: Only those Hookup items in the Hookup Items Catalogue that have been set to
'Allow' are shown by default in this selection list. See the Hookup Items Catalogue for
more information. 
Uncheck the Show Allow Only checkbox to list items not marked set to ‘Allow’.

Select Items or Components

Double-click on as many items as required.

Use the Find toolbar command to search for any specific text in the grid.

To exit the window, click Close.

Note: Each time an item is selected, the item is added to the list of items in the Hookup
Template Details window. If the same item is selected more than once, the quantity
of that item is incremented each time. The quantity may also be manually changed
by editing the quantity value in the Hookup Template Details window.

Filter the Catalogue Items List

Filter the items catalogue by selecting a size from the Size list. The “All” option resets the
filter so that all items are shown.

Note: When selecting a size, AVEVA Instrumentation finds any component matching the
size anywhere within the catalogue size field. A size may also be typed in (e.g 1/4"
OD and the <Enter> key pressed to filter the items by that size.

7.6.5 Assign Hookup DataLinks in AutoCAD
To assign or modify DataLinks to an AutoCAD Hookup template the file first must be opened
using AutoCAD (refer to Issues when Opening AutoCAD Drawings).
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The Hookup Template can be opened in AutoCAD by using the Open Drawing button on
the Hookup Template Details window (refer to Open the Template in AutoCAD / Select an
existing AutoCAD drawing to be used as the Hookup Template).

Use the AVEVA Instrumentation Designer AutoCAD Menu

When assigning new DataLinks (or modifying DataLinks already assigned) first ensure the
Designer AutoCAD menu is loaded into AutoCAD. This toolbar menu should be
automatically loaded when an AutoCAD drawing is opened from Designer.

Note: If the 'iDesigner' menu is not auto loaded the Designer.mns menu will need to be
loaded manually (using the AutoCAD 'menu' command). 
The menu files are located in the AVEVA Instrumentation program installation folder.

Assign/Edit DataLinks

Once the AutoCAD iDesigner menu is loaded, select iDesigner from the pull-down menus,
then Edit DataLinks.

This displays a window showing all attributes in the selected AutoCAD block.

AutoCAD will prompt users to select objects. 

Select a block with attributes, and then press enter. AutoCAD will display the Edit
DataLinks window:

This window shows all attributes and DataLinks defined in the block selected.

Note: To view available Keyword DataLinks for any drawing in the Designer's Drawing List
open the DataLinks Window. This window includes 'copy and paste facilities' of
DataLinks from the report window into the AutoCAD Edit DataLinks window.

In the example above, the Description attribute has three Datalinks assigned. This will
update the attribute value with item Description, Size and Material for the first item assigned
to the hookup (e.g. Description1, Size1 and Material1 return the values for Item 1).

To assign a DataLink, either type in a valid DataLink or copy it from the DataLinks Window
(using Windows copy and paste - Ctrl-C / Ctrl-V etc) or by dragging and dropping from that
window (hold the Ctrl key and drag the report DataLink to a field above).

Refer to DataLinks for more information on DataLinks.
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Copying Blocks with DataLinks in AutoCAD

Since DataLinks are defined as Extended Entity Data within AutoCAD, their behaviour is
same as Xdata. That is, if a block is copied with DataLinks attached, the DataLinks are
copied too. This can drastically reduce data entry when setting up DataLinks.

For example, required DataLinks can be attached to a block that may represent a Field
Device. That block can the be copied to as many drawings as required, saving the effort of
re-entering the DataLinks each time. Another example is the Title block used in all drawings.
Set-up the first drawing with all DataLinks, and once it has been tested, copy that Title Block
(which may contain multiple AutoCAD blocks) to the other drawings.

Auto-Erasing Blocks with DataLinks in AutoCAD

Designer provides an 'Auto-Erase' (or auto-delete) function where a block will be
automatically erased from a drawing if a specific DataLink returns nothing. If a DataLink
attribute is prefixed with <DEL> and AVEVA Instrumentation detects that the following
DataLink has no value, then Designer will erase the block containing the <DEL> Datalink.

For example, it is required to erase a block if there is no tag number for {TAG10}. Entering:
<DEL>{TAG10} in for an attribute in a block will tell AVEVA Instrumentation to erase the
block if {TAG10} evaluates to nothing (i.e. there is no TAG10 for this drawing).

7.7 Hookup Items Catalogue
The Hookup Items catalogue is used to add and edit the Hookup items for the project.

To open the Hookup Items catalogue, click Select in the Grids and Schedules section of
the Home tab.

Select Hookup Items from the list of grids that is then displayed. The Hookup Items
Catalogue grid is then displayed:

7.7.1 Adding a New Catalogue Item
To add a new Hookup Item to the catalogue, with the Hookup Item Catalogue grid open,
click New on the Home tab. 

The Hookup Item Detail window is then displayed:
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Field Information

Category can be any text value, for example 'Ball Valve' or 'Male Elbow' etc. The category
field is automatically filled with all the unique categories already defined in the catalog.
Additional categories may be created by entering them. They will then be added to this list.

User Code is the code that will appear on the Hookup Drawing. This is a simplified code
that for example could be a three digit number, so that all 1/2" Unions would be a 101 etc.

User Catalogue No is an optional field used to enable materials management systems to
track the component. For example a SAP code. MESC number etc.

Contingency allows the project Bill of Materials report to be increased by a specific number
of items to allow for spares or runover. This is ideal for tube and/or unions where it may be
appropriate to allow some additional quantity to ensure the site has some extra items.

Enter an exact number (e.g 2 or 10 etc) or a percentage by entering a number and the
percentage character '%' (e.g 2% or 5% etc). 

Check the Allow use on Project checkbox to allow the item to be selected and used on the
project. If the checkbox is not checked, the item will not be listed in the Find a Component
window, used to add items to Hookup templates (refer to Assign Hookup Items to
Templates).

Details

Description is the detailed description of the item that will be seen on hookup drawings.

Manufacturer and Catalogue No are the manufacturer and model number details used to
purchase the item.

Size and Material are more information to describe the item.

Unit is the unit of measure (e.g each, metre, ft etc).
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Import from Excel

Hookup items can also be imported from Excel.

For a description of this functionality, refer to the Common Functionality User Guide.

Import from another Project

Items can also be imported from another project. This works the same way as the facility for
importing Hookup templates from another project. Refer to Import Hookup Catalogue for
details.

7.8 Hookup Reports
The following reports related to Hook-ups are available in Designer:

• BOM/Material Take Off
• Tags Assigned
• Tags not yet Assigned

These are accessed from the Reports grid.

The BOM/Material Take Off report lists the Hook-up items that comprise the project Bill of
Materials. 

The report is displayed in the Hookup Bill of Materials window:

An item is added to the BOM by assigning it to a Hookup drawing and unchecking its No.
checkbox (see Assign Tags to a Hookup).

The Tags Assigned report lists the tags assigned to Hookup drawings in the project:
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The Tags not yet Assigned report lists the tags not yet assigned to Hookup drawings in the
project:

Only those tags that are pre-assigned via Hookup type (template) are listed.

For descriptions of the toolbar buttons of the Tags Assigned and Tags not yet Assigned
report window, refer to Reports.
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8 Engineering Data

AVEVA Instrumentation Designer allows access to the Instrument Engineering data
normally created by the Engineer application. 

Refer to the Instrument Engineer User Guide for further details.

8.1 Loop Data
Loop data is viewed in the Loop Data window.

This window can be accessed from two places in Designer:

1. In the Drawing Information window (refer to Add a New Drawing), click the button in
the Loop No field (only available if the Drawing is a Loop Diagram).

Or:
2. From the Drawing List grid list, click the button in the Loop No cell, which appears

when the mouse hovers over the 'Loop No' cell. 

If the drawing has not been assigned to a loop, the Assign Drawing to Loop window is
displayed, which provides a list of Loops defined in the Instrument Engineer application.
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Double-click on the required Loop, or select it and click Assign. 

Use the Display by Area list to filter the list of Loops by an area.

The Loops button accesses facilities for creating new Loops. Refer to the Instrument
Engineer User Guide for further details.

If the drawing has been assigned to a loop, the Options window is displayed:

Clicking Edit Loop Detail displays the Loop Edit window, displaying details of the Loop:
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This window enables users to:
• Edit Loop information (including checking Drawing Required).
• Editing Instrument Tag data (double-clicking on any tag in the Loop Instruments list will

display the Instrument Data window).
• Add new tags/instruments to the current loop (use the Add Tag button to display the

Assigning Tags to Loops.
• Check the loop instrument wiring including terminations (via the Loop Check Wiring

button).
• Create Loop wiring for current Loop based on user defined Wiring Rules (via the

Create Loop Wiring button - refer to Using Wiring Rules to Create Data for more
information).

• Remove existing Loop wiring using the Remove Loop Wiring button.

Note: The Last Edit field displays the date and time when the loop data was last edited.
The user name of the individual that performed the edit is displayed in a tool-tip when
the mouse cursor is hovered over the field. Click the button in the field to display the
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Audit Manager, which will display a list of all the changes to the loop data.

Related Loops

Up to two 'related loops' may be assigned. This enables AVEVA Instrumentation to place
information for related loops (including their instrument tag data) on any Loop Diagram
created with Designer. To assign a related loop, click the button inside a Related Loops
field This displays a Select a Related Loop window, from which a Loop may be selected.
This window works in a the same way as the Assign Drawing to Loop window (see
above).

Loop Instruments List

The Loop Instruments list shows all instruments assigned to the current Loop.
• To assign Instrument Tag Numbers to the Loop click Add Tag. The Add Instruments

to Loop window. Refer to Assigning Tags to Loops for further information.
• To edit instrument data, double-click on the desired tag number. Refer to Instrument

Data for further information.
• To remove a tag from the current loop, select the instrument tag record and press the

<Delete> key.
• To change the loop order of instruments drag and drop each to the required position.

8.1.1 Assigning Tags to Loops
In the Edit Loop window (see Loop Data), click Add Tag to display the Add Instruments to
Loop window.

The left hand list shows typical tags and descriptions for the Engineer's ISA tag catalogue
built using the current Loop function prefix in the Edit Loop window.

The right-hand list shows all tags assigned to the current loop (if any).

To assign a tag to the current loop use one of the two following methods:

1. Build a Tag Number using the ISA tag catalogue (left list)

Double-click on the required tag and the full tag number is added to the right-hand list.
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Note: If the tag being built does not exist in Engineer's Instrument List it will be added. If it
does exist, AVEVA Instrumentation will reassign the tag to the current loop.

2. Pick an existing tag number from the Instrument List

Click the From Instrument List button, which displays the Select Instrument to add to
Loop window, used for selecting tags not assigned to any loop. Continue at Select Existing
Tags for details.

8.1.2 Select Existing Tags
When the From Instrument List button in the Add Instruments to Loop window is clicked
(see Assigning Tags to Loops) the Select Instrument to add to Loop window is displayed:

This window contains only those tags yet to be assigned to a loop. The tag list can be
filtered to enable easy access to tags by area, using the Display by Area list.

Assign a Tag to the Current Loop

To assign a single tag, double-click on a tag number to assign the selected tag to the current
Loop. 

To assign multiple tags, check the checkboxes for all the tag numbers to be assigned, and
click the Assign button.

The Match Number checkbox filters the list of loops by the tag number. 'number' field. In the
example above selecting Match Number would limit the list of loops to only those containing
'510' if the current instrument was numbered '510'.

8.2 Instrument Data
Designer provides access to the Instrument Engineering data normally created by the
Instrument Engineer module. The Edit window for instruments is accessed from the Loop
Edit window (see Loop Data).
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In the Loop Edit window, double-click on any tag listed in the Loop Instruments list.

The Edit window for instruments is then displayed. For example:

The two important fields for loop drawing generation are found on the Detail tab:
12 Series8:6© Copyright 2000 to current year.
AVEVA Solutions Limited and its subsidiaries. 
All rights reserved.



Instrument Designer User Guide
Engineering Data
1. Wiring Config - this applies the selected Wiring Rules to the instrument. See Wiring
Rules Overview.

2. Loop Dwg Code - this is the code number used when Designer creates DataLinks. In
the example above the Loop Dwg Code is 1 meaning that all tag DataLinks will be
created prefixed '{TAG1'. If the code was 51 then all DataLinks would be created
prefixed '{TAG51' This field is only used for generation of DataLinks used to create loop
drawings from templates.

Note: AVEVA Instrumentation recommends using the same Loop Dwg Code for each
instrument type. e.g. Always use 10 for transmitters, 50 for Control Valves etc. This
means the Datalinks users embed into the CAD symbols can be copied without to
much thought since it is likely that users will use the same CAD symbol for each
transmitter, control valve etc.

Click on this link to view information on Edit Tag Details - Tabs.

Many field options have a user definable PickList associated. Clicking on the # command
button next to a combo box displays the PickList Management window.

Note: The Last Edit field displays the date and time when the instrument data was last
edited. The user name of the individual that performed the edit is displayed in a tool-
tip when the mouse cursor is hovered over the field. Click the button in the field to
display the Audit Manager, which will display a list of all the changes to the
instrument data.
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8.2.1 Edit Tag Details - Tabs

General

The General tab is used to enter typical common data for most instruments on the project.

Detail

The Detail tab is used for more detailed design data and includes data typically required for
wiring and installation information.

The Wiring Config PickList is used to assign a Wiring Rule to the instrument. The name is
used to auto generate the instrument termination arrangement including terminal details,
cable type, connection arrangement and wire ferrule numbers etc. Typically this choice is
made by the person responsible for detail wiring design. It can also be edited from the
Designer and Wiring Manager applications.

The Junction Box in-cell command button displays an Assign window which allows the
user to assign the current instrument to a Junction Box.
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Click Create Tag Wiring to display the Create Tag Wiring for window. Refer to Using
Wiring Rules to Create Data for further information. 

Clicking Tag Wiring Check displays a report showing wiring connectivity for the current tag.

Datasheet

The Operating Principle PickList is used to pre-assign an instrument to a data sheet form
type. 

The Sizing Calculation button is used to display windows used to perform sizing
calculations for the instrument. If no sizing calculations have been performed for the
instrument, the button will display a list of sizing calculation types to select from. 

If a sizing calculation or calculations have been performed, the last type of calculation
performed is displayed under the button. The button will open the window used to perform
that calculation.

To select a different calculation to perform, double-click on the calculation type name under
the button. The list of calculation types is then displayed.

The button in the Datasheet No. field provides access to the datasheet (if it exists). If the
tag is not yet assigned to a datasheet the user is allowed to assign the current tag to an
existing datasheet using the Add Datasheet for window. 

For more details of sizing calculations and datasheets, refer to the Instrument Engineer
User Guide.
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DCS System

The DCS System tab is used to assign DCS I/O information for the current tag (if the current
tag will be connected to the DCS System). 

Important: The DCS I/O Type must contain a non-blank value for the current tag to be
assigned to an I/O Module in Wiring Manager and to allow wiring to be
completed to the I/O terminals.

PLC/ESD System

The PLC/ESD System tab is used to assign PLC or ESD (Emergency/Safety Shutdown) I/O
information for the current tag (if the current tag will be connected to the PLC or ESD
System). 
12 Series8:10© Copyright 2000 to current year.
AVEVA Solutions Limited and its subsidiaries. 
All rights reserved.



Instrument Designer User Guide
Engineering Data
Important: The PLC I/O Type must contain a non-blank value for the current tag to be
assigned to an I/O Module in Wiring Manager to allow wiring to be completed to
the I/O terminals.

User

Instrument Engineer has twenty-four user defined fields (UserField1 to UserField24). The
User tab shows sixteen of these user fields (the others can be added to any grid view).

Alarms/Settings

Use this tab to enter Alarm and Settings data required for the instrument.
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Properties

Use this tab to enter additional instrument and process data properties as required. Click on
the appropriate Select Properties Type option and enter or edit values as required.

Power Supply

Used to enter details of any power supply requirements for the instrument. If appropriate,
check the Requires Power Supply checkbox and enter the details in the fields provided.

If the instrument data is to be shared with AVEVA Electrical, click Share with Electrical.

Note: Unless sharing with AVEVA Electrical is enabled for the project the checkbox will be
disabled. Sharing with AVEVA Electrical may be enabled during project setup, or
afterwards (using the Project tab > Edit Project option). Refer to the Installation
User Guide for details.
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Associated Items

Used to view the process equipment and lines associated with the instruments, to add
further associations, and to remove associations.

The Properties button is used to open the Edit Process Equipment or Edit Process
Lines window for the process item selected on the tab, in which further details of the item
can be viewed. Refer to the Process Engineer User Guide for further details.

8.3 Loop Check Wiring Reports
Loop Wiring Check Reports show a graphical 'loop diagram' type report of all wiring for
current loop. The report may be printed and saved as a PDF file. This report is only
available if the drawing has a valid loop number and wiring exists in the project wiring
database for the instruments in the current loop.

Create a Loop Wiring Check Report

Click on the Loop Wiring Check button in the Loop Edit window (see Loop Data). The
Loop Check Report window is then displayed. For example:
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The report may be sent to a printer saved the to a file in Adobe Acrobat PDF format by
clicking the Print and Export to PDF buttons. From the Setup button, facilities are available
to change print properties such as page size and orientation etc.

When exporting to PDF format, AVEVA Instrumentation creates a file named after the Loop
Number. The file name for this example would be: 00-F-510.pdf.

Double-click on the report to zoom in or select a zoom ratio from the list of options after

selecting the Zoom button: .

Note: If the PC has a license for Wiring Manager, on any equipment tag is right-clicked on,
AVEVA Instrumentation will display an option to allow access to the Wiring
Manager's Terminations window, which provides drag and drop editing of cable/wire
terminations, and an option to generate a termination report for the selected
equipment.

Note: If the PC has a license for Wiring Manager when any cable is right-clicked on,
AVEVA Instrumentation will display an option providing access to Wiring Manager's
Cable Detail window, which is used to view and edit the details of the cable.

8.4 Equipment Data
Designer provides access to the following equipment and termination viewing and editing
facilities in Wiring Manager:

• The Layout window, which is used to view internal equipment component layouts in a
graphical user interface.

• The Terminations window, which is used to edit wiring terminations and rearrange
terminal strips etc.

• The Termination Report window, which is used to preview, print a graphical
representation of the equipment termination, and export it to various file formats.
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• The Select Equipment window, used to select or change the equipment that the
termination drawing is for

Accessing Wiring Manager Facilities

Either click on the command button next to Equipment No field in the Drawing Information
window (see Add a New Drawing - only available if the Drawing is a Termination Diagram).

Or click on the button in the Equipment No cell in the Drawing List, which is displayed when
the mouse cursor is hovered over it.

The Options window is then displayed:

• Click Edit Detail to display the Layout window.
• Click Edit Termination to display the Terminations window.
• Click View Termination to display the Terminations Report.
• Click Change Equipment to display the Select Equipment window.

Refer to the Wiring Manager User Guide for details of these facilities.
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9 Using Wiring Rules to Create Data

AVEVA Instrumentation uses 'Wiring Rules' to auto generate typical field instrument wiring/
cabling. 

Continue at:
• Wiring Rules Overview
• Using Wiring Rules
• Create Loop Wiring using Wiring Rules
• Assign a Junction Box

9.1 Wiring Rules Overview
AVEVA Instrumentation uses 'Wiring Rules' to auto generate typical field instrument wiring/
cabling. Using the Wiring Rules features can save many hours otherwise required to build
devices and their associated terminal arrangements, cables, terminations etc in Wiring
Manager.

For how to apply a Wiring Rule refer to Create Loop Wiring using Wiring Rules.

When a Wiring Rule is applied to a field instrument, the following are defined:
• Terminal Arrangement - number of terminals, their markings, sequence.
• Default wire numbers to be used on wire terminations.
• Default Cable Type - type of cable (individual cores, pairs or triad etc), whether

shielded/screened, and whether armoured etc.
• Default Cable Number, based on the instruments tag number fields from Instrument

Engineer.
• Default Wire terminations at field device - how the cable is connected to the field device

terminals (core 1 to terminal 1, core 2 to terminal 2 etc).
• Default wire terminations at non-field device - how the cable is connected at the other

end.

When Wiring based on a Wiring Rule is created, AVEVA Instrumentation creates all the
above automatically. Prior to saving this data AVEVA Instrumentation also enables users to:

• Change the default Cable Number created by the Wiring Rule.
• Select equipment the cable will terminate to at the other end (provides a list of Junction

Boxes, Cabinets etc).

After accepting defaults (or making changes as required) the Field Device and terminals are
created, cable created and terminated at both ends (if equipment has been selected at the
other end). At the other end, AVEVA Instrumentation always uses the next available spare
terminals.

At any time after a Wiring rule is applied, the data that has been generated can be edited by:
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1. Re-running the Create Wiring command using same Wiring Rule - this enables users to
reassign a Cable No, reassign a Junction Box etc.

2. Re-running the Create Wiring command using a new Wiring Rule - this updates
terminal arrangements, cable type, terminations and enables users to reassign a Cable
No, reassign a Junction Box etc.

3. Edit the cable details/type (using the AVEVA Instrumentation Cable Schedule user
interface).

4. Edit terminations (using the AVEVA Instrumentation Terminations editing user
interface).

Note: Equipment Terminations can also be accessed directly from Designer. Refer to
Equipment Data for details.

9.2 Using Wiring Rules
Designer provides access to two Wiring Rules commands from the Loop Edit window. 

Access the Loop Edit Window

From the Drawing Information window (see Add a New Drawing), click the button in Loop
No field (only available if the Drawing is a Loop Diagram).

The Loop Edit window is then displayed:
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Below the Loop Instruments list there a three buttons:
• Loop Wiring Check: Displays a report showing all the instrument wiring associated

with the current loop. Refer to Loop Check Wiring Reports.
• Create Loop Wiring: Creates loop wiring from the Wiring Rules applied to the each

instrument in current loop. Refer to Create Loop Wiring using Wiring Rules.
• Remove Loop Wiring: Removes any previously created loop wiring from the field

instruments in current loop.

Note: The Loop Instruments list shows the name of a Wiring Rule associated with each
instrument (Wiring Rule column).

9.3 Create Loop Wiring using Wiring Rules
Note: Although Wiring Rules can be used to create field cables/terminations from Designer,

this is limited to working on a Loop by Loop basis. AVEVA recommends creating field
wiring using Wiring Rules from the Wiring Manager's Equipment View or Cable Block
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Diagram by assigning (allocating) field tags to Junction Boxes, which is more efficient
than doing it in Designer by each Loop.

Instrumentation can create the field device, terminals, cables, cores and wire numbers and
terminate cable cores at both the field device and Junction box cable ends based on
assigned Wiring Rules Overview for each specific Loop instrument. This effectively
completes field wiring in a very efficient and simple manner that can save hundreds on man-
hours on a large project.

Note: The loop must have tags assigned. To assign tags to a loop, use the Instrument
Engineer application facilities.

Note: AVEVA Instrumentation uses Wiring Rules when tags are assigned to Junction
Boxes in Wiring Manager. See the Wiring Manager User Guide for more information.

Create Loop Wiring using Wiring Rules

In the Loop Edit window (see Loop Data), click the Create Loop Wiring button. The
Create Loop Wiring window is then displayed:

This window lists all the instruments assigned to the current loop.
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Columns Explanation

Select Only those instruments that have their Select checkbox checked are
processed when the Create command is used.

TagNo The instrument tag number - non-editable (tags can only be assigned
to a loop using Engineer).

Note: Although the Wiring Rule (Wiring Config) defines the terminal arrangement of the
Field Device a different type can be selected by clicking the button in Tag No cell
that appears when the mouse hover over this cell.

Code The 'Loop Code' is used by AVEVA Instrumentation Datalinks to map
information into a loop drawing template when generating CAD
drawings. It is ONLY required if CAD loop drawings are to be
generated in Designer. This 'Loop Code' must be unique for the
current loop for CAD loop drawing creation.

WiringRule The name of the Wiring Rule to apply to the tag. Select the required
rule from the list of available rules (the list is only displayed when the
mouse is hovered over the cell).

Junction Box This displays the name of the equipment the cable will run to. A button
is displayed when the mouse is hovered of this cell. Clicking on that
button will display a window used to Assign a Junction Box. 

Terminate When this checkbox is checked, cores will be terminated at the
Junction Box end (on the next available spare terminals). When it is
unchecked, cores will not be terminated at the Junction Box end. The
cores will need to be terminated manually, using Wiring Manager, by
dragging the cable or cores to the desired terminals.

Cable No. This shows the default cable number as created by the wiring rule or
the actual cable number from the AVEVA Instrumentation Cable
Schedule (if the cable has been created previously). Enter a new
value if required.

Length Enter a Cable Length here. This length is saved in Wiring Manager's
Cable Schedule.

Cable Type This shows the base cable type. It can be changed by selecting the
cell command button that appears when the mouse is hovered over
this cell. The initial cable type comes from the Wiring Rule catalogue
cable (if the cable is not yet created) or from the Cable Schedule (if the
cable has been created previously). Clicking the cell button displays
the Catalogue Cable window allowing a new catalogue cable to be
selected.

Command Buttons

Create Creates all selected tags, cables, termination and other wiring data
from the Wiring Rules and data in this grid.
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Note: Wiring Manager allows limited editing of the predefined Wiring Rules. Limitations are
that only Cable No, Wire No, Terminal Marking and Cable Types can be changed.

9.4 Assign a Junction Box
When selecting a Junction Box when creating loop wiring (see Create Loop Wiring using
Wiring Rules), the following Assign window is displayed, initially listing all junction boxes
defined in the current plant area:

Select the All Areas option to view equipment in all plant areas.

To assign a Junction Box, double-click on the required equipment tag.

Junction Boxes and other Equipment (other than field devices) can only be created in the
Wiring Manager module.

Note: The instrument Signal Type is shown near the top of this window. This comes from
the Instrument's Signal Type field in the AVEVA Instrumentation Instrument Data
window. However any instrument may be assigned to any junction box, regardless of
signal type. 

Save Saves the changed data in the grid, but does not create Wiring Rule
data. This enables users to pre-assign junction boxes etc prior to
cable/device creation.

Cancel Exits the window, not saving or creating wiring.
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10 Exports

The export options available on the Manage and List Tools tabs are described below.

Continue at:
• Export to Excel
• Export to XPS and PDF Files
• Export Selected Drawing Files
• Export to AVEVA NET

10.1 Export to Excel
The contents of the Drawing List, Seed List, Hookup Drawing List, Hookup Catalogue and
Hookup Items Catalogue grids can be exported to an Excel spreadsheet with same layout of
columns and rows.

Data can also be exported to an Excel spreadsheet from a number of windows that display
data in a grid.

For a description of this functionality, refer to the Common Functionality User Guide. 

10.2 Export to XPS and PDF Files
The contents of the Drawing List, Seed List, Hookup Drawing List, Hookup Catalogue and
Hookup Items Catalogue grids can be exported to PDF and XPS files.

For a description of this functionality, refer to the Common Functionality User Guide.

10.3 Export Selected Drawing Files
The drawing files (.dwg files) of drawings selected in the Drawing list grid can be exported
to:

• a folder specified at time of export with file names formed from the drawing number and
sheet number in the normal way, and

• a pre-defined folder or folders with file names in a pre-defined, user-defined format.
The folder(s) and the file name format are specified using facilities accessed from the
Setup menu on the Project tab, as described below.

The.dwg files of the selected drawing must be present in the Drawing folder of the project.

10.3.1 Export Drawings to a Specified Folder
Select the drawings in the Drawing grid or the Hookup Drawings grid.
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On the List Tools - Drawing tab, click Selected Drawings in the Export section, then
Copy/Archive to a Folder from the menu that is then displayed.

The Export folder window is then displayed:

Use the window to select the folder to which the drawings are to exported. Browse to the
required folder and double-click on it to select it.

If drawings are to be exported to a new folder, enter the location and name of the new folder
in the New folder name (if required) field. 

Click OK. If it was specified that a new folder is to be created, a message is displayed
requesting that this be confirmed.

The export of the selected drawings then takes place. A message is displayed when the
export is completed, for example:
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10.3.2 Export Drawings to Pre-Defined Folders with File Names in a Pre-
Defined Format
Before drawings can be exported using this option, the folder or folders to which they are to
be exported and the format of the drawing file names must be defined.

Setting the Folder Name and File Name Folder

To specify the folder and sub-folders that drawings are to be exported into, and the files
names that they will be given, click Setup on the Project tab. On the Setup menu, click
Export File Name/Folders.

The File Export Settings window is then displayed:

In the Root Folder field, enter the root folder under which the sub-folders that contain the
exported files are to be located. Click the … button to browse for the required folder.

If no sub-folders are specified, as described below, all the files will be exported into this
folder.

To specify the sub-folder structure, select the drawing datalinks that will define the names of
the sub-folders and from the Sub Folder list.

To select a datalink, check the appropriate datalink checkbox. The selected datalink is then
displayed in curly brackets in the field below the list. 

Datalinks are provided to enable users to include sheet numbers and the sheet number
totals displayed with 1, 2 or 3 digits. For example, for a drawing with a sheet number of 1 out
of a sheet number total of 2, the following datalinks would return the values shown below:

{Sheet} 1

{Sheet2dig} 01

{Sheet3dig} 001

{NoOfSheets}  2

{NoOfSheets2dig} 02

{NoOfSheets3dig} 002

As required, enter delimiter characters or text between the selected datalinks in this field.
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To specify the file name format of exported drawings, follow the same procedure as for sub-
folders, but using the File Name list and field.
Example:

In the example above, a sub-folder structure of {ProjectNo}-Area{Area} and a file name
format of {DwgNo}-{Sheet}-{Rev} have been selected. The selected root folder is
"C:\AVEVA".

Using these settings, from a project called "Project1", drawings are exported with the
following details:

This will result in the creation of folder structure and files as follows:

C:\AVEVA (root folder)

Project1-Area00 (sub-folder)

ABC123-1-RevA.dwg (exported drawing file)

Project1-Area01 (sub-folder)

XYZ890-1-RevB.dwg (exported drawing file)

Export Drawings

Select the drawings in the appropriate grid.

On the List Tools - Drawing tab, click Selected Drawings in the Export section, then
Copy to User Defined Names from the menu that is then displayed.

Note: Drawings may also be optionally exported when they are updated. Refer to Create or
Update Drawings.

The export of the selected drawings then takes place. A message is displayed when the
export is completed, for example:

Area Drawing Number Sheet Number Revision

00 ABC123 1 A

01 XYZ890 1 B
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10.4 Export to AVEVA NET
AVEVA Instrumentation Designer includes facilities to export files of drawing data and report
PDF files for import into AVEVA NET.

The following can be exported:
• Drawings data
• Hookup Drawings data
• Reports and associated item data (i.e. of the items on the reports)

The files produced by the exported can subsequently be imported into AVEVA NET Portal
(refer to AVEVA NET documentation for details).

10.4.1 AVEVA NET Export Configuration
Before files can be exported for AVEVA NET, the export must be configured.

From the Project tab, click Setup, then Publish to AVEVA NET Configuration. The
AVEVA NET Export Configuration window is then displayed.
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Instrumentation data of various types and from different sources can be exported to AVEVA
NET, for example drawing data or data from reports. From the Name field, select the type of
data export to AVEVA NET to be configured.

If a log file is to be generated for the export type, check the Log Enabled checkbox. 

The Log File field will then become enabled. In the field, specify the file name and the
location of the log file (a .txt file). Click the adjacent button to browse for the required folder. 

In the Staging Area field, specify the top level folder into which files are to be exported.
Click the adjacent button to browse for the required folder. 

If the Create Trigger File checkbox is checked, a trigger.start file (an empty text file) is
created in the staging area folder for each file type. The purpose of the trigger.start file is to
trigger the AVEVA NET Portal’s import controller to automatically process all the files that
reside in the same folder.

To select mapping files for the export of data and specify other settings, click Settings.

If Report exports are being configured, the Non-CAD Mapping Configuration window is
displayed.

If Drawings or Hookup Drawings exports are being configured, the CAD Mapping
Configuration window is displayed.
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Mapping Setup

The mappings between Instrumentation data and AVEVA NET Portal format data are stored
in XML files, one for each of the types of mapping:

• Presentation Mapping (Drawing and Hookup Drawing exports only)
• Object Mapping
• Class Mapping

For details of these files, refer to AVEVA NET Export Configurations Files.

In Non-CAD Mapping Configuration window and on Mapping tab of the CAD Mapping
Configuration window, click the appropriate … button to browse for the required mapping
file.

Click the open file button  to open the selected file. It will open in the default text editor,
for example Notepad. 

If no file is specified in the field, a new, blank .txt file is opened. If a file is specified that does
not exist, the user will be prompted to create that file at the specified location. If Yes is
clicked, a new blank .txt file is created and opened for editing.

To populate the fields with the default mapping files supplied with AVEVA Instrumentation,
click Copy Sample Files.

On the Mapping tab of the CAD Mapping Configuration window, if unmapped attributes,
i.e. Instrumentation attributes not mapped to AVEVA NET Portal characteristics in the
Attribute mapping files, are to be exported to export files as characteristics, check the Keep
Unmapped Attributes checkbox.

Other Settings (for Drawings and Hookup Drawings Exports)

Additional export settings may be specified for the export of Drawings and Hookup
Drawings on the Settings tab of the CAD Mapping Configuration window.

To select the background colour of the SVG files generated by drawing exports, either:
• select the required colour from the Colour field list, or 
• enter the RGB values of the colour in the fields provided, or
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• press the Pick Colour button and select the required colour from the standard colour
selection dialog.

In Scale Factor field, enter the stroke-width attribute value of lines in the output SVG files.

10.4.2 Export Data from Grids
To export data from the Drawing List grid, Hookups grid or Reports grid, select the items
from the grid and from the Manage tab, click Publish to AVEVA NET in the Integration
section.

The Export To AVEVA NET window is then displayed, showing the progress of the import.

Once the export is completed, the Export Report window is displayed, listing the items for
which the data export was requested and whether or not that export was successful or not:
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10.4.3 Export Overview
AVEVA Schematic Gateway is a common Gateway that will be used by different AVEVA
schematic applications to export various kinds of data to AVEVA NET. This Gateway refers
to various configurations which are provided to it through various configuration files
(described in sections below). 

As of now, AVEVA Schematic Gateway processes data (provided to it in a form of a Dataset)
as well some external files (Excel spreadsheets - xls and xlsx, PDF files). 

• Data provided to the Gateway through dataset gets processed and output gets
generated into EIWM format.

• Gateway processes excel spreadsheets and produces output in MHTML format.
• Gateway processes PDF files and produces output in PDF format.
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11 Work Packs

Work packs can be created which consist of collections of items with shared project
management requirements or properties. For example, all the items an individual user or
group of users is concerned with may be assigned to a single work pack. Time constraints
may be assigned to work packs, for example the required start and completion dates of
items in the a work pack, so that work can be more easily prioritised.

For a description of this functionality, refer to the Common Functionality User Guide.
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12 Change Reports

The following change reporting facilities are available in AVEVA Instrumentation:
• Audit Manager
• Database Revisions

12.1 Audit Manager
AVEVA Instrumentation has an in-built Audit Manager that enables users to view database
changes made during the project in the database audit log.

For a description of this functionality, refer to the Common Functionality User Guide.

12.2 Database Revisions
AVEVA Instrumentation allows users to make a copy of the current database state by saving
the database as a Database Revision. At any time, the current database can be compared
to a saved Database Revision. This feature can be used to track changes between key
milestones in the project, for example between data when documents were 'Issued for
Tender', 'Issued for Purchase' or 'Issued for Construction'. 

For a description of this functionality, refer to the Common Functionality User Guide.
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13 Reports 

AVEVA Instrumentation provides facilities for creating and modifying reports. These are
available with the Reports grid. 

For a description of these features, refer to the Common Functionality User Guide.

In addition, the following Designer-specific “fixed” (non-editable) reports are accessible from
the Reports grid:

DataLinks for
Selected Drawing

If a single Drawing is selected, this command displays the
DataLinks Window which displays all the Datalinks available for
the drawing, including values returned by each DataLink based
on current project data.

Templates Used Displays the Templates Used in Projects window, which shows
all Templates used by Designer, and the number of times they
have been used in the project. Refer to Open a Template
Drawing with AutoCAD.

BOM/Material Take-
off

Displays the Hookup Bill of Materials window. Refer to Hookup
Reports.

Tags Assigned Displays the Tags Assigned to Hookup window. Refer to
Hookup Reports.

Tags not yet 
Assigned

Displays the Tags not yet Assigned to a Hookup window.
Refer to Hookup Reports.
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A AVEVA NET Export Configurations Files

The following configuration files will be used by the AVEVA Schematic Gateway to process
the input:

• Project Configuration
• Presentation Mapping (Drawing and Hookup Drawing exports only)
• Object Mapping
• Class Mapping

For a description of these files, refer to the Common Functionality User Guide.
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